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Introduction to ArcGIS 10 exercise

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

This exercise is designed to help you get familiar with elements of ArcGIS – specifically 
ArcMap and the “Catalog” window (also called “ArcCatalog”).  

Note: Data for all exercises are available at: 
http://courses.umass.edu/nrc592g-cschweik/data.html

Lab Setup

1. Get data files 

a. The data we will use is available on the course calendar under today's date. It 
is a zip file. Create a folder on your C: drive called “C:/temp/gisdata”. Click 
on the link under today's class entry on the course calendar and save to 
c:/temp/gisdata (unless I tell you otherwise in class).

b. Using My Computer, navigate to c:/temp/gisdata. Right-click and unzip the 
introArcGISdata.zip (use unzip to here). You should see the following files 
appear: 

 cut_tm_reg_chitwan_00.rrd (satellite image file of an area of Nepal)
 cut_tm_reg_chitwan_00.img (satellite image file of an area of Nepal)
 fmisheadworks.mdb (geodatabase file of irrigation headwork points)
 headworkcov, info folders (arc info coverage)
 a bunch of files with the first name “hw”. One has an extension of 

.shp (ArcView shape file). 

Getting Started: Let’s look at the Menus of ArcMap

1. Start up ArcMap 10 (Start, programs, ArcGIS, ArcMap 10). 

Create a new “blank map.” Click “OK” on the ArcMap – Getting Started page.
An untitled, ArcMap document should appear. 

Note the “Table Of Contents” section on the left side of the screen.

There are the Magnifier and other tools in one of the icon rows below the main 
menus. 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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The main “map area” is the large area below the menu and icon bars that covers 
the middle and the right side of the screen. 

Look at the main menu. It follows the general standard kind of menu system 

File – Add layers, print functions, open or new ArcMap, save, page 
properties, etc.

Edit – copy, cut, paste, paste special, find
Bookmarks – this menu allows you to create and manage particular 
geographic locations that you can save and reference later. This might be a 
study region, for example.

View – Data view, Layout view (map making); Graphs and Reports.

Insert – Data frame (a collection of layers drawn in a particular order for a 
given map extent), also mapping (cartography) functions such as text on 
the map, legends, north arrow, scale bar, etc.

Selection – This is an important menu for “querying” the GIS database. 
Here you can highlight spatial features using different “selection” 
approaches, such as “Select by Attributes,” Select by Location,” or “Select 
by Graphics”. We’ll use some of these functions later in the course. 

Geoprocessing – This menu provides a number of tools used for analysis. 
Buffering, Clipping (cookie cutting) out a region of interest layer editor, 
intersecting two layers, doing a union between two layers, etc. This is also 
where you can invoke the “Modelbuilder” tool. (We’ll be doing an 
exercise on that later) and you can program “scripts” using a language 
called Python. There is also a “Search for Tools” option on this menu and 
you can access ArcToolbox here which has all the analytic tools ArcGIS 
provides. There are a ton of tools!

Customize – This is an important menu because this is where you can turn 
on various “extensions” needed. For example, to do work with raster data 
(such as a Digital Elevation Model – a grid of elevation data that is 
commonly needed for environmental management applications) you 
would need to invoke the “Spatial Analyst” extension. You need to first 
use the Customize, Extensions option to select the extension you want, 
and then once that is “clicked on,” you can go into Toolbars to display the 
toolbar for that particular extension.

Click on the Extensions menu. What do you have available to you? Make 
sure Spatial Analyst is clicked on. Then go to Customize, Toolbars and 
select the Spatial Analyst. You should see a new menu appear labeled 
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“Spatial Analyst.” You’ve just invoked that tool. You can close it using 
the “x” on the right of that toolbar. 

Windows – Changes the mapping window. You can invoke the 
“magnifier” tool window here (we’ll use that in georeferencing), and other 
important windows like Catalog (the file management tool in ArcGIS), the 
Table of Contents (displayed on the left side of ArcMap).

Help – help system

2. Review the main icon menu – This is much like other software you may be familiar 
with. Icons for: New map file, open (a map) , save a map document, print, cut 
(scissors), copy, paste, X (delete selected element), arrows (undo, redo), + (add data), 
map scale, editor toolbar icon (pencil), Invoke Table of Contents window, Invoke the 
Catalog window (the very small file cabinet icon), the Search window, Invoke the 
ArcToolbox window (toolbox icon), the show the Python scripting language window, 
the invoke the Model Builder window and the “What’s This?” pointer tool. 

You also should see the magnifier (+,-) icons which allow you to zoom in and out of 
you map. The little white hand is the Pan tool that allows you to move around the 
displayed map. The Globe icon zooms out to the full extent (the largest geographic 
area of all your layers). The arrows in and out zoom you in and out. There is a lback 
arrow (the select elements tool), there is an “i” in a circle which is the Identify tool – 
you can click on spatial features to look at their corresponding database record using 
this tool) and the binoculars is a find tool. There are a few less important icons that 
we haven’t mentioned. 

3. For map construction, there is a Drawing toolbar (Customize, toolbars, Draw) that has 
the standard tools like “A” for writing text, and then ways to set the font used, make 
the text bold, etc. This is useful for when you make maps (we’ll do that in a later 
exercise). 

4. Note on the ArcMap screen, bottom right, there is information on the coordinate 
system used. In a blank map they will have 0,0 somewhere near the bottom left of the 
map area on the screen. Move your cursor around to see the coordinates change – 
they are reporting the location of where your mouse cursor is. Not also that currently 
the map is set to “Unknown Units” meaning it doesn’t know whether you want to use  
meters, feet or some other unit.

Using the “Catalog” Window

We jumped the gun with ArcMap. Typically before we start mapping layers, you begin 
work in the Catalog Window of ArcGIS. 

The Catalog (also called “ArcCatalog) is the tool for browsing, organizing, distributing, 
and documenting an organization’s GIS data holdings. In this exercise you will explore 
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ArcCatalog and ArcMap while creating a basic map of some farmer irrigation 
“headwork” points in Nepal collected using a GPS and a motorcycle.

5. Invoke the Catalog. Click the “Catalog window” icon in ArcMap (the icon with the 
very small file cabinet) or 

a. Start button 
b. Programs
c. ArcGIS
d. Click ArcCatalog 10
e. ArcCatalog starts, and you should see two panels in the ArcCatalog window. 

The Catalog tree on the left side of the ArcCatalog window is for browsing 
and organizing your GIS data.  The contents of the current branch are 
displayed on the right side of the Catalog window. Your window should look 
something like this (this is an older snapshot from ArcGIS v9 but it looks 
much the same):

6. Note on the left side you should see some hard disk references (e.g, C:\) and also 
some entries for 

a. Folder connections – allow you to connect to various folders on your 
computer.

b. Toolboxes – This is where you can store some of the models you make or get 
access to other ArcGIS tools.

c. Database Servers – These are to access larger, enterprise level database 
servers that store geodatabases (we’ll talk about geodatabases more in future 
exercises)

d. Database connections. This is another component of using a larger database. 
We won’t really use this in this class.

e. GIS Servers – these are remote servers that can be accessed over the Internet. 

7. Connecting to your data
a. When you start a new project, you’ll have a folder location where this data is 

stored. Let’s connect to the data folder for this exercise (recall above 
c:\temp\gisdata). 
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File, Connect Folder. Navigate to the c:\temp\gisdata folder where the data 
we copied are stored.  Click OK. 

b. The new connection appears as a branch in the Catalog tree (left half of the 
window).

8. You should see some new files listed in the right window. 

Note that in Catalog there is an icon that has four little boxes called the “Contents 
View Type” icon. If you click the down arrow, you’ll see that you can list your 
files or see the details of them. I like the “Details” option for it provides more 
information about your data files. Click on the “Details” icon (a little table-like 
structure). 

a. Fmisheadworks.mdb (Personal geodatabase)
b. Headworkcov (an old ArcInfo coverage)
c. Cut_tm_reg_chitwan_00.img (a raster dataset)
d. Hw.shp (a Shapefile format)

These are a set of GIS data that are from Nepal, where I was studying farmer 
managed irrigation systems in a remote area in the southern part of that country. 
A “headwork” is the location where an irrigation system meets a river. These are 
point locations that were collected using Global Positioning Systems (GPS). 

The Geodatabase, coverage and shapefile are the same point data in different GIS 
data formats. 

These file formats match the history of the ArcGIS software. In the early days it 
was a “coverage.” Then “Shapefile”. Then personal geodatabase. Now there’s 
also a “File Geodatabase” (we’ll build that later in the class). 

9. If you double-click on the FMISHEADWORKS personal geodatabase, you will see 
its contents.

a. Headworksgeodb (a point “feature class”)
b. This geodatabase only has one layer in it. The headwork points.
c. You can right-click on any of the datasets and click “Item Description” from 

the “context menu” (context menus are menus that popup when you right 
click). 

In these datasets I’ve been a bad GIS manager – something you should never 
do! I haven’t entered any data description information about the dataset – 
referred to as “metadata.” In a future class, we’ll do more work with metadata.  

d. Close the Item Description window to return back to Catalog. 
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Using ArcMap

ArcMap is the tool for creating, viewing, querying, editing, composing and publishing 
maps. For those of you who have seen or used the older ArcView 3.2 product (something 
some government agencies still use), it is like the “View” component of that system. 

10. If you don’t have ArcMap open, start it up (Start, Programs, ArcGIS, ArcMap 10). 
Organize the windows of ArcMap and Catalog so you can see both of them. I usually 
have ArcMap on the left and taking up the majority of the screen. I have Catalog on 
the bottom right and smaller. But however you organize your screens, just get them so 
you can see both at the same time. 

11. In the Catalog window, double click in the fmisheadworks geodatabase so that the 
Headworksgeodb appears. Left-click and drag the “Headworksgeodb” point layer 
over to the ArcMap table of contents. You should see a point layer appear in the right 
window and a checked entry in the TOC. 

12. Now let’s display the raster Landsat image file. Click back on the Catalog window.
13. Use the “go up one level” yellow arrow icon to move to the next higher folder 

(C:\temp\gisdata). 
14. Click on the raster file (cut_tm_reg_chitwan_00…) and drag it over so that it is listed 

BELOW the point layer. You might get a message about data sources using different 
coordinate systems…  just click close. We’ll discuss the important concept of 
coordinate systems in a future class. 

15. You should eventually see the image of a portion of Nepal (Himalayan foothills 
toward the north) displayed and the points overlaid.

16. Note the coordinates from the map projection being used at the bottom, right hand 
corner and how they change as you move the cursor around the map. Notice too that 
the units of this coordinate system is Meters.

Map Tools
The tools toolbar provides functions that help you navigate around the map. The 
below is a snapshot of the toolbar from ArcMap 9.3, but it looks much the same in 
ArcMap 10. 

Specific tools:
 Zoom in and out (the magnify tool + and -). Zoom in and notice how the map 

scale at the top of the window changes. GIS is “scale-less” which is why it is 
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important as to what scales input maps were at so you don’t try to use the GIS at 
inappropriate scales!

 Back button (left arrow) – Jumps you back to the previous spatial extent.
 Full extent button (the globe) – Displays the fill extent of the map.
 Find a feature (the binoculars) – 

o Let’s try finding the point that is called “bk1” in the headworksgeodb. 
o Click the binoculars.
o In the Find Window’s “Find:” field, enter “bk1” 
o In the “In:” field, choose the “headworksgeodb” layer. 
o In the Search: option, click on “in field:” and choose the “System_Cod” 

database field.  
o Click “Find”
o BK1 should appear as a value in the find window. 
o Move the Catalog window down so you can see most of the ArcMap 

screen and the gps locations on the Landsat image. Move the Find window 
off to the right so it is not blocking the point locations. 

o Click on the BK1 entry in the bottom of the Find window and watch the 
points on the map. Do you see one of the points flash with a large green 
dot (or some colored dot)?

o Right click on the BK1 in the bottom of the Find window and in the 
context menu select “Zoom to” – this will zoom in the map to show you 
the point more clearly. (You also start to see the pixels in the landsat 
image at this finer scale).  

o Use the Globe icon in the ArcMap icon menus to zoom back to the full 
extent of the layers (zoom to a broad scale view). Now you’ll see the 
entire Landsat image including its boundaries.

o Close the Find window.  

Adding New Layers

 So right now we’ve added one geodatabase layer and the raster image using 
“drag” from ArcCatalog

 You can add datasets to ArcMap using the “Add Data” icon (the yellow diamond 
with a black plus sign) to add the headwork ArcInfo coverage (headworkcov). 
You might have to navigate in the Add Data window to the c:/temp/gisdata folder. 

This is the same point data as the headwork layer in the geodatabase, it is just 
stored in a different format (ArcInfo coverage) which is the oldest but still 
somewhat common format of GIS data found on the Internet.

Change TOC information

17. Let’s change the Table of Contents information for these layers in ArcMap. 
a. Right click on the headworks coverage entry: “headworkcov point”.
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b. Choose “properties” from the menu. This is an important function, and it 
shows you lots of information about the particular dataset you are working 
with.

c. Notice what tab is opened (General, Source, etc.)
d. Click the General Tab
e. Change the Layer name to “Headwork coverage”
f. Click OK. The TOC entry should be changed.

18. Change the color of this point layer to yellow
a. Right click on the “dot” below Headwork coverage
b. Choose yellow.
c. Notice that the points on the map change to yellow. Whatever layer is at the 

top of the TOC will be displayed on top.
19. You can move what layer is viewed “on top.” For example, move the raster image to 

the top of the table of contents
a. In the Table of Contents, there are several icons. The first one on the left is 

called “List by Drawing Order”. Click on that and you’ll see theTOC entry 
format change.  

b. Left-click and hold on the “cut_tm_reg_chitwan_00” image
c. Holding the left click, drag this up to the top of the TOC
d. You should see the points disappear because the raster grid is overlaying on 

the points. 
e. That provides an example of how to move the order of the “draping” of layers 

in ArcMap. Whatever is listed on top is viewed on top. Raster images on top 
“blanket” vector (point, line or polygons). So usually rasters are left at the 
bottom with often the vector on top.

View Attribute Data 

20. Some of the real power of GIS is that you can store data associated with layer 
features. So for example, there is a small database associated with the head work 
point locations. We’ve already used it when we did the “Find” command to look for 
the headwork named “BK1”. But let’s look at the entire database associated with this 
point layer.

a. To look at the associated attribute database for the headwork features, 
b. Right click on a table of contents entry  for the “headworkgeodb” point layer
c. Choose “Open Attribute table.” A “Table” screen will appear.
d. Scroll to the right to view various records of data
e. These are various irrigation systems, their names, and various field data we 

picked up doing surveys of the farmers. For example, the “conflict” field is a 
measure from a survey instrument on the extent of conflict they have over 
water resources.

f. Click on the left gray area for system code “BK5”
g. Move the attribute table window so you can see the points on the map.
h. The associated BK5 point will be highlighted, or “selected.” This is an 

example of a very simple database query. By clicking on the row, you’ve 
asked the system “Show me this point on the map.”
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i. Note at the bottom of the database window it says 1 out of 39 selected. The 
computer remembers features that are selected when we do database queries. 
This is important to remember because in later analyses if a subset of records 
is selected this could cause you problems. 

j. One way to clear the selection, is to push on the “Clear Selection” icon in the 
icon menu on the Table window.  At the bottom it should reset to 0 of 39 
selected.

k. Close the attribute table window.

To conclude today’s lab, let’s look at the files on the harddisk to see how all this is 
stored. 

21. Click on the X in the right hand window of ArcMap to close it. 
22. At the question “Save changes to untitled?” say “yes”
23. Navigate to your work folder (c:/temp/gisdata). Save as “Nepal Irrigation.mxd”

a. Important note! You’ve just stored a new “ArcMap document.” The 
Windows extension name is “.mxd”. This is basically the Map View of your 
datasets with the table of contents as you’ve organized them. It has links to the 
datasets and displays them, but those datasets are stored in their own files. So 
our Nepal GIS project now contains both the Nepal Irrigation.mxd document 
(the ArcMap document) and also the dataset files that it uses. 

24. Close ArcCatalog
25. Find Windows Explorer
26. Navigate to c:\temp\gisdata
27. View details if you don’t have that option on.
28. What files\folders do you see?  

What are the files\folders associated with the Geodatabase (New ArcGIS format)? 
Fimisheadworks Microsoft Access Database (.mdb)

What do you think are the files\folders associated with the shape file (Old 
ArcView format)?

Hw.shp
Hw.shp XML document
Hw.shx
Hw.dbf (this is the database or “attribute table”)
Hw.prj – this is a file that stores the “projection” information. We’ll be 
talking about that in future classes.

What do you think are the files\folders associated with the older ArcInfo 
coverages? Look in the folders to see all the various files.

Two folders and all their contents
Headworkcov
info
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Among other things, Geodatabases are an improvement because things are all stored in 
the one database file. Rather than all of these separate files. Data backup is a big and 
important issue in GIS given all the files a project usually has associated with it.



Searching for Data – MassGIS
 Importing MassGIS Data into ArcMap: 

MassGIS Highway Roads and a USGS Topographic map example

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

The reason we start with MassGIS in this class is because at our institution, many people want to 
work on projects in Massachusetts and MassGIS is a terrific resource for GIS-relevant data. 
There are often comparable websites for other states as well, although Massachusetts does this 
particularly well. 

In this class we will:

1. Learn how to find a scanned and georeferenced topomap from Mass GIS for the UMass 
campus (MrSID format) and download it

2. Download the Massachusetts highway roads file
3. Read their metadata in the MassGIS dbase file
4. Define their projections in ArcCatalog – THIS IS A CRUCIAL STEP YOU WILL USE 

OVER AND OVER!
5. Display them in ArcMap

NOTE: STEP 7 BELOW is particularly important to remember. It shows you how to define a 
new layer’s projection in ArcCatalog.

1. Create a directory in c:\temp\gisdata if one does not already exist. Erase old files in it if it 
does exist.

2. Go to the MassGIS site: http://www.mass.gov/mgis

Review the MassGIS Overview page. http://www.mass.gov/mgis/dd-over.htm 

Obvious (but important) question: What datum, projection and units are all the 
MassGIS data in?

The datum for the MassGIS database is North American Datum 1983 (NAD83). 
The data are registered to the Massachusetts State Plane Coordinate System, 
Mainland Zone (Fipszone 2001). Units are meters.

3. Go back to the main MassGIS site. http://www.mass.gov/mgis/  

In this exercise we will download two layers: the USGS topographic map for the town 
of Amherst and the corresponding MassHighway roads layer.

4. Let’s first download a 1:25,000 scale USGS topographic map grid 
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Note: if you are unfamiliar with some of the available USGS maps at different spatial 
(map) scales, see http://erg.usgs.gov/isb/pubs/booklets/usgsmaps/usgsmaps.html  

See if you can figure these questions on your own (the answers are provided at the 
end of this document). 

Question 1: Where on MassGIS can you find USGS topographic maps at 1:25,000 
map scale?

Question 2: Which quad map number(s) covers the town of Amherst? What is a 
MassGIS “tile”?

Question 3: Can you successfully download the Amherst “tile” #117902 as a MrSid 
image?

The answers to these questions are at the end of this lab.

5. Now let’s download the corresponding Mass Highways roads layer for this same area. 
See if you can figure this out on your own. 

Question 4: Where can you download this data on MassGIS?
 
Download the roads layer for the “Town Tile” for Amherstr.  These are shapefiles 
that are stored in an executable zip file (.exe extension). 

Using the Firefox browser, you can right click on the Amherst shape file 
(eotroads_8.exe) and choose “save as.” Save to your c:/temp/gisdata folder.
.
Why should you be careful about downloading .exe files? – because they are 
EXECUTABLE files (programs) and can contain viruses. But MassGIS is a “safe 
website” so it is OK to do.

Once you have stored it on your desktop computer, you need to unzip the data. 
To “Unzip” the roads shape file in executable format (.exe) you just downloaded, 
you simply find the file in Windows Explorer and double click on it. You should 
see several files appear that are all related to the ESRI shape file format. Notice 
the types of files produced.

What projection is this layer in? How would we find out? See the next step.

6. Understanding MassGIS metadata

a. First we need to understand how to work with the metadata. 

Question 5. Does anyone have an idea of what file of the ones downloaded store the 
metadata for this layer? 

Question 6. How would you read the metadata? What projection is this data in?

The projection is State Plane NAD 1983, the units are in meters. The same is true 
for the topomap. 

Now let’s pull it into ArcMap. (NOTE: ALL MASSGIS DATA IS IN THIS 
PROJECTION!)
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7. Define the shape file’s coordinate system to ArcCatalog *** NOTE! THIS IS 
IMPORTANT AND SOMETHING YOU WILL HAVE TO DO ANYTIME YOU HAVE A 
NEW LAYER!!! ***

1. Start ArcCatalog 
2. Navigate to C:temp/gisdata
3. Right-click on the shapefile whose coordinate system you want to define 

(etoroads_8.shp). 
4. Click Properties. 
5. The spatial information should have been carried down and should be there. This 

is because a .prj (projection) file was downloaded.
6. If the projection didn’t come down (which may be the case in some MassGIS 

data, you’d have to define it). 
7. You’d click on the X/Y Coordinate system tab.
8. Click the Select button and then click the “projected coordinate system.”  (What is 

“geographic” versus “projected” coordinates telling you?)

Select the State Plane, NAD1983 (NOT FEET! – METERS!), and find the
“NAD 1983 StatePlane Massachusetts Mainland FIPS 2001.prj” 
projection

9. Click OK in the Spatial Reference Properties dialog box. 

In the Shapefile Properties dialog box, the name of the coordinate system 
appears next to the Spatial Reference 

10. Close the window. 

8. What about the Mr. Sid topo image? 

We have to do a similar process to see if the projection info is known or 
unknown.
Right click on the Sid image. 
Choose properties. 
Scroll down to “Spatial Reference” – see if the projection information is listed.
The projection is known at this point, and this is because the “MrSid world file” 
was downloaded with the raster layer that had the projection information within it. 
If it wasn’t, we’d have to do a similar process (don’t do the below unless the 
projection information is unknown):

Edit the spatial reference information.
Select.
Projected coordinate systems.
State plane.
NAD 1983
Massachusetts Mainland. Click Add. You should see projection info 
appear.
Click OK. 

9. Start ArcMap. Let’s look at the roads layer draped on top of the MrSid topomap. 
a. Drag the roads shape file layer – etoroads_8.shp from the ArcCatalog window to 

the TOC in ArcMap. 
b. Drag the Mr.sid image over and place BENEATH the ETOroads in the TOC. 
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c. You may have to move your Arc Catalog window to see the topomap
d. Use the zoom in magnifying glass to zoom in to the Umass campus topo. 

This exercise is completed!

Answers to some of the Questions above: 

Question 1. Where on MassGIS can you find USGS topographic maps at 1:25,000 scale?

Download Free Data, Read Metadata/Download Data, Image data, Scanned Reference 
Maps, USGS Topographic Quadrangle Images. http://www.mass.gov/mgis/im_quad.htm

Question 2. Which quad map is the one for the town of Amherst? What is a MASSGIS “tile” # for 
the town of Amherst?

To find this out, I find the pdf  available at http://www.mass.gov/mgis/ix_topo.pdf  is 
helpful (this is the “index map” link on http://www.mass.gov/mgis/im_quad.htm). Use the 
magnifying glass to zoom in to read map details. Amherst falls on the boundaries of four 
USGS 7.5 minute quad maps: Mt. Toby (#43), Mt. Holyoke (#44), Shutesbury (#49) and 
Belchertown (#50).  

BUT… as noted on page: http://www.mass.gov/mgis/ftpquad.htm  

“The Scanned USGS Topographic Quad Images are available on MassGIS in TIFF 
and MrSID (a compressed file) format. The images are tiled as 4 kilometer 
squares, to match an Orthophoto Index, rather than by the original 7.5-minute 
sheets used by the U.S. Geological Survey for its paper map versions.” 
 
So we actually need to find the “tile number” for the area that includes the town of 
Amherst. 

On the above webpage (…ftpquad.htm) click on: MrSID “download area” 
(http://www.mass.gov/mgis/ftp_usgs_topo25k_sid.htm), then choose the “Orthophoto 
Index” link (http://www.mass.gov/mgis/ix_oq.htm). Then view the PDF version of the 
Statewide Map (http://www.mass.gov/mgis/ix_oq.pdf). Do a find on “Amherst” and zoom 
in.

Write down one of the Amherst orthophoto tile numbers -- 117902. 

Question 3. To download tile #117902 in Mr Sid format: 

Note: MrSID is an acronym for Multi-resolution Seamless Image Database, a powerful 
wavelet-based image compressor, viewer and file format for massive raster images that 
enables instantaneous viewing and manipulation of images locally and over networks 
while maintaining maximum image quality. The reason we will use MrSid is because it is 
a smaller file to download, compared to a TIFF file (the other available format). 

Available on the “download areas” on this page: http://www.mass.gov/mgis/ftpquad.htm 

Go to the “USGS Topographic Quadrangle Images – MRSID Format” Download page. It 
is better if you try and navigate and find this page again on your own, but if you can’t find 
it, it is here: http://www.mass.gov/mgis/ftp_usgs_topo25k_sid.htm. 
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The files are provided in a .zip (compressed format). Find the zip file for 117902. (Helpful 
Hint: in your browser, do a Edit, Find for the number):

- q117902.zip is what you want to download. This compressed file needs to be 
UNZIPPED using an unzip software. Your computer might be able to 
recognize this, but in case it can’t, you need to find an Unzip program on 
your computer. One that is freely available is 7-zip (7-zip.org). Within this file 
are three files that, together, make up the raster topomap for the town of 
Amherst:

- q117902.sdw – the georeferencing information (Mass State Plane)
- q117902.sid – the image grid 
- q117902.aux – some additional information

To download, using Firefox, right click on each file and “save link as” to folder 
c:\temp\gisdata. Note: MassGIS historically gets overloaded and times out. If it doesn’t 
work the first time, you may have to try several times. Eventually, a list of MrSid tile files 
should appear. (Different browsers act differently – but somehow using your browser you 
should be able to download the zip file to your computer). 

Question 4. Where can you download the Mass Highways data for Amherst on MassGIS?
Download, Vector Data, Infrastructure, MassDOT Roads, 
Download these layers” link. (See http://www.mass.gov/mgis/eotroads.htm)

Question 5. There is an XML file (etoroads_8.shp.XML).that was downloaded with the other 
shape file data. What is XML? eXtensible Markup Language. It uses various “tags” to label parts 
of data. This is quite handy in part so that computers can talk to each other and share data using 
these tags. 

Question 6. How would you read the metadata? What projection is this data in?

Open up ArcCatalog and navigate to the layer you downloaded. View the metadata via the 
Metadata tab. State Plane, NAD83 

15

http://www.mass.gov/mgis/eotroads.htm


16

The “quick list” of US and Global GIS data websites
September 2011 version

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-NonCommercial-
ShareAlike 3.0 Unported License. To view a copy of this license, visit 

http://creativecommons.org/licenses/by-nc-sa/3.0/.

This page provides a list of some of the resources out on the Internet that provide access to GIS-related 
data. In our classroom setting, we will take some time to review/try out a sample of these sites and 
discuss how you download data you identify. 

General information on searching the Internet. The UC Berkeley librarians have provided a very nice 
overview summarizing a broader Internet search approach that helps you do a more thorough search 
than simply “going to Google.” 

http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/FindInfo.html

Federal Geographic Data Commission – www.fgdc.gov 

US Geospatial data websites

1. http://www.Data.gov – Try out the geodata catalog and the tool catalog
2. www.Geodata.gov  – Federal portal to lots of GIS data
3. www.usgs.gov\ngpo (national geospatial program)
4. www.Geographynetwork.com   – ESRI run data portal
5. http://seamless.usgs.gov – seamless data (meaning no map edges) for download
6. http://edcsns17.cr.usgs.gov/EarthExplorer/  - USGS Earth explorer – lots of data for download 

or purchase – especially satellite imagery, aerial photos, etc. This was around before 
Geodata.gov and data.gov

7. http://www.census.gov/ - Look at Geography, TIGER – this is where Census data are (e.g., 
Blocks or Block Group – note that .shp is a defacto standard…

8. http://www.nationalatlas.gov/  - Note the “mapping professionals” – here you can get “raw” 
GIS data including some national layers related to census info

9. Topoquest – USGS Topomaps (GeoTiff) http://www.topoquest.com/
10. Fish and Wildlife service list of New England GIS sites -- 

http://www.fws.gov/northeast/gis/stategis.html 
11. Open Topography (US NSF funded) website - 

http://opentopo.sdsc.edu/gridsphere/gridsphere?cid=datasets  

NonSpatial Data 

1. http://www.fedstats.gov 

Just a few international sites

1. German Earth Observation Center - http://eoweb.dlr.de:8080/index.html

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/FindInfo.html
http://www.fgdc.gov
http://www.fgdc.gov
http://www.fgdc.gov
http://www.fgdc.gov
http://www.fgdc.gov
http://www.Data.gov
http://www.Geodata.gov
http://www.usgs.gov\ngpo
http://www.usgs.gov\ngpo
http://www.usgs.gov\ngpo
http://www.Geographynetwork.com
http://seamless.usgs.gov
http://edcsns17.cr.usgs.gov/EarthExplorer/
http://www.census.gov/
http://www.nationalatlas.gov/
http://www.topoquest.com/
http://www.fws.gov/northeast/gis/stategis.html
http://opentopo.sdsc.edu/gridsphere/gridsphere?cid=datasets
http://www.fedstats.gov
http://www.fedstats.gov
http://www.fedstats.gov
http://eoweb.dlr.de:8080/index.html
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Here you can get, among other things, Space Shuttle Topography data for most of the 
entire terrestrial earth. 

2. Global spatial data infrastructure association - 
www.gsdi.org and its http://www.gsdi.org/SDILinks.php page (lots of links to other 
international data sites)

3. Free GIS, Remote sensing and hydrology blog - http://free-gis-data.blogspot.com/ 
4. www.fao.org/geonetwork - Food and Agriculture Org site
5. http://geodata.grid.unep.ch/ - United Nations Environmental Program’s geodata portal
6. http://www.gbif.org – Global Biodiversity Information Facility (Denmark)
7. http://www.naturalearthdata.com/ -- Natural Earth – free global data 

http://www.gsdi.org
http://www.gsdi.org/SDILinks.php
http://free-gis-data.blogspot.com/
http://www.fao.org/geonetwork
http://www.fao.org/geonetwork
http://www.fao.org/geonetwork
http://geodata.grid.unep.ch/
http://www.gbif.org
http://www.gbif.org
http://www.gbif.org
http://www.naturalearthdata.com/
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Internet Scavenger Hunt – Fall 2011

Your task today is to find a georeferenced 1:24,000 scale USGS topomap of the area around the town of 
Manistee, Michigan. Specifically, locate a “GeoTif” (TIF file) for use in ArcGIS. (note: In a USGS site, I 
found a version in “GeoPDF” which is not ArcGIS compatible). To do this, go back to some of the “Quick 
List of GIS data websites” I showed you). At least one of them has the data you want on it and it can be 
downloaded, unzipped and viewed in ArcGIS. 

Note that topomaps can be referred to as: (1) 7.5 Minute Quads or (2) Digital Raster Graphics.

Once you find one that looks usable, make sure you check the website about what the datum and 
coordinate system it uses. 

Make sure the dataset coordinate system is set using ArcCatalog.

Good luck!

 

Charles M. Schweik

This work is licensed under the Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported 
License. To view a copy of this license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/ 
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Answer – Internet scavenger hunt – Fall2011

This is the answer key to an in-class exercise on finding GIS data on the Internet.

An easy way to find it is to Google and find topoquest.com . The issue with using those Tiff files is that 
they are not georeferenced. You’d have to georeference them yourself. What we want is already 
georeferenced scanned images. 

One way I successfully did this was the following:

1) Went to https://edcsns17.cr.usgs.gov/NewEarthExplorer/  – USGS “Earth Explorer”
2) Search Criteria – can zoom into the area of Michigan and look for the town “Manistee”. Click on 

the town to create a “thumbtack”
3) Datasets tab – choose “Digital Maps” , Digital Raster Graphics 
4) Click on “Results” tab.  Datasets appear. One of them is called “Manistee.”
5) EROS requires you to create a userid and password to download. So create that. 
6) Download – Now this is confusing. 

a. it is a zipped (tgz) file
b.    After downloading unzip using 7-zip. But it produces ANOTHER zip file (o45123d7.tar)
c.    Unzip again. Produces a tif file and a .tfw (tif world) file.   

 

Charles M. Schweik

This work is licensed under the Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported 
License. To view a copy of this license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/ 

https://edcsns17.cr.usgs.gov/NewEarthExplorer/
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Creating an Arc Map project (*.mxd) document that can travel.
(Portable ArcMap Document)

 
2011 Maria Fernandez, Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.
 

Sometimes you need to move your GIS project to other computer, save it to some media 
and use it somewhere else, or share it with other people at your enterprise or company. 

The Arc Map document contains links to all the data sets present in the document, as well 
as information to display such data sets. Such links are preserved in the form of “paths” 
to the data, that you can see when you click “source” tab in the table of contents.

If at any time you change the location of some of the data layers, the map document is 
going to be pointing to a wrong location and the data won’t be able to be displayed:

When this occurs, you can fix individually each link right clicking the data set, going to 
properties, source, and “SET DATA SOURCE”, browsing to the new location of the data 
set. 

http://creativecommons.org/licenses/by-nc-sa/3.0/


21

That’s how you fix the links if the need arises, but there are several ways to minimize 
those broken links. 

One is “don’t mess” with your data sets, moving them between folders… if you need to 
move a data set, just copy it and paste it in other location, leaving a copy wherever Arc 
Map wants to find it. 

But this is the most general way in which you can move a whole project successfully to 
other computer: when you create the Arc Map document, or at any time, you can make 
those links to the data “flexible” or portable, so when you open your Arc Map document 
somewhere else, Arc Map can find the data and display in the table of contents. 

In ArcMap – Go to FILE > MAP DOCUMENT PROPERTIES > Click “Store 
relative path names to data sources”. DONE! 

As long as you move the folder with the data layers and the *.mxd Arc Map document all 
together, you can put it in any location in other computers. 
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Do some experiments saving arc map projects using this option, and saving them to a CD 
and opening them in other computers. You can also practice this principle just moving 
the folder to other location in your computer. REMEMBER: *.mxd project does not carry 
the DATA!!! Only the paths or links to the data. You need to save and move the data 
layers together with your Arc Map project. 
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Georeferencing a scanned map using ArcCatalog, ArcMap and the 
Georeferencing Tool

 
2011 Charlie Schweik, Alexander Stepanov and Lara Aniskoff

Note: This work is licensed under the Creative Commons Attribution-NonCommercial-
ShareAlike 3.0 Unported License. To view a copy of this license, visit 

http://creativecommons.org/licenses/by-nc-sa/3.0/.

Note: before the lab copy the exercise dataset (amhersttopo.jpg) from the exercise 
manual data repository to a new directory in the C:\temp\GIS folder.

1 Overview:
A common GIS development task is the need to digitize data off of a paper map. 
There are two main ways to do this: 1) Digitize using a digitizing tablet (this was the 
old way – not done as much now); and 2) do on-screen digitizing from a background 
(scanned) image of the map. 

This document describes part of the process for on-screen (#2) on-screen digitizing: 
Getting a background image georeferenced so that you can do online digitizing using 
it, or simply use it as another GIS (raster) layer.

1. First, you must identify the map you want to digitize and check it for metadata. 
a) Check for georeferencing coordinates (are there long/lat lines on the 

map? UTM coordinates? What kind of datum/map projection is it in?) 
(See Appendix A for an example from a USGS topomap).

b) You must also check for some usable Ground Control Points. These 
are points on the coordinate grid that you can easily see and calculate 
X,Y coordinates based on the projection the map is in. (See Appendix 
A)

2  Scan the map to a JPG or TIFF file
You need a scanner to scan your map. If it is a large map, you need a large (map) scanner 
(often available in copy stores). 

Before you do the scan, make sure you note the coordinates of grid lines that will be in 
your scanned image. Refer to Appendix A “Amherst Topo Map” as an example. It is 
critical that you include some grid “crosshairs” that you can use as ground control points.

Scan the map to a TIFF file (or better yet a jpg file if the scanner software will do it). 
Refer to Appendix B, to learn about some of the different image formats. 
On the class website for this class you there is a scanned topographic map of the campus 
in jpeg format (amhersttopo.jpg). To use such data in a GIS we must first georeference it. 
If we brought it in to ArcMap as it is, it would have a simple Cartesian plane coordinate 
system that is based on the number of pixels in the file.  We want to assign the .jpg file to 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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the correct projection system that it represents, and thus change the coordinate system to 
represent this projection. 

This involves (a) specifying the jpg (or tiff’s) coordinate system in Arc Catalog; (b) 
Specifying the coordinate system for the image

Digitizing specific control points; and (c) Rectifying or “stretching” the scanned image to 
fit the new projection. 

3 Specifying the coordinate system for the image
3.1 Start ArcMap and open the ArcCatalog window by clicking on the icon in the toolbar 
or on the tab on the right of the screen.

3.2  Navigate to the folder you created on the c:\temp drive and find amhersttopo.jpg 
within ArcCatalog.
3.3 Right-click on the Amhersttopo.jpg and select properties.
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3.4 Locate the “Spatial Reference” option in Raster Dataset Properties dialog window. 
(it should say “undefined”). 

3.5 Press the “edit” button to specify coordinate system information. The Spatial 
Reference Properties window will appear.

3.6 Press the “select” button to specify projection information for scanned image [ this 
information are usually available from descriptive text on the map. Please refer Appendix 

Right-Click to select 
“Properties”
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A to obtain detailed information about scanned image]. The projection information on the 
map is shown in Appendix A. What projection is it in?

Answer: UTM, NAD 1927 Zone 18 N

Select “Projected Coordinate Systems” > utm > nad 1927 > nad 1927 utm zone 18N.
”Press the “Add button”. The projection information will be summarized in the “spatial 
reference properties” window.

NAD_1927_UTM_ZONE_18N
Alias: 
Abbreviation: 
Remarks: 
Projection: Transverse_Mercator
Parameters:
  False_Easting: 500000.000000
  False_Northing: 0.000000
  Central_Meridian: -75.000000
  Scale_Factor: 0.999600
  Latitude_Of_Origin: 0.000000
Linear Unit: Meter (1.000000)
Geographic Coordinate System: 
Name: GCS_North_American_1927
Alias: 
Abbreviation: 
Remarks: 
Angular Unit: Degree (0.017453292519943295)
Prime Meridian: Greenwich (0.000000000000000000)
Datum: D_North_American_1927
  Spheroid: Clarke_1866
    Semimajor Axis: 6378206.400000000400000000
    Semiminor Axis: 6356583.799998980900000000
    Inverse Flattening: 294.978698200000000000

3.7 Press “OK” or “Apply” button to apply your settings. By performing this operation 
you have added cartographic information to the scanned image. 

3.8 Press “OK” again to leave the properties window.
Now that we have told ArcGIS what projection the image is in, we can now turn to 
georeferencing of the image. 

Now with the project properties “attached” to the scanned image, we can start 
georeferencing the image.

4 Georeferencing an Image – The Georeferencing Tool
4.1 This step involves identifying “ground control points” where you know the x,y 
coordinates. 
4.2 Drag the amhersttopo.jpg from the ArcCatalog window into the main ArcMap 
window, or “Add File” to the ArcMap window. It may ask you to “build pyramids.” Say 
yes. This is to make the computational processing easier for the computer.
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4.3 Right click  in the empty space by the toolbar and click on “Georeferencing” to 
invoke Georeferencing tools menu. You should see this: 

4.4 If you had a GIS layer already georeferenced and projected, you could use the “add 
control points” tool to match control points on this jpg to the GIS layer already 
georeferenced. In this case the computer would take the coordinates from the already 
projected layer and copy assign the same coordinates to the control point you digitized. 

If you don’t have an already georeferenced GIS layer to work with, you can use the add 
control point tool specify control points on the image and enter the coordinates by hand 
in the “link” table. In situations where you are establishing the first layer of a GIS using a 
scanned map like a topographic map, you would use this second option – and that’s what 
we’ll do here. We’ll 

a) Locate and define control points with “add control point” tool, and 
b) Enter in the x,y projection coordinates for each control point with “view link 

table” tool.

4.4.1 Invoke the “magnifying window”: select in main menu toolbar “Windows” > 
“Magnifier”. Use the map Appendix A to work from. 

4.4.2 Click on the “add control point” icon; in addition click on the View Link Table 
icon. You should now have both the Magnifier and Link Table windows open. 

4.4.3 Use the “Magnifier” window and navigate to the control point 1. Press the left-
mouse button to set the ground control point, then make the second click. Do this for the 
other 3 points following the order in Appendix A. (see figures below). Make sure you do 
it in the order we’ve specified in Appendix A! (bottom left, top left, top right, bottom 
right)

Add 
Control 
Points

View 
Link 
Table

Operation 
type
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This is a little tricky. At each point, left-click once to set the point on the image. A 
second click sets corresponding point in the real-world space/coordinates (which at first 
will be the same). 

Scanned Image

Magnification 
Window

Control Point
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After identifying all four points (and in more extensive GIS work you would use many 
more points than just four, perhaps up to 30 or more scattered throughout the map). 

Now go to the “Link Table” window. Select the first record and enter the precise 
coordinates into “X-Map”, “Y-Map” fields based on the projection coordinates on the 
paper map. See Attachment A for the coordinates for each control point. Make sure you 
enter the right coordinates for each – this is CRITICAL! 

Repeat the operation for all 4 points. You will see the map do some strange things behind 
the link table as it gets “stretched” to conform to this new coordinate information. You 
will also get a warning saying that the coordinates are “collinear”. In a real world 
exercise you would try and choose more points that were well distributed around the 
map.

Please, pay attention to the RMS value [‘Residual’ field]. Its value should not be greater 
than .5 (1/2) pixel. If you get a Total RMS error score larger than .5 you need to delete 
the control point contributing the most to the error (largest residual) and try and re-
digitize it. This is sometimes a long, tedious process.  

When you are satisfied, press the “OK” button on the Linking table to apply results. 

b) Enter X 
coordinate 
For the Control 
Point Here

a) Click on a record 
to select

c) Enter Y 
coordinate for the 
control point here RMS should be 

< 0.5. Re-enter 
GCP if RMS > 0.5
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5 Image Rectification – “Stretching” the image to the designated 
geographic area
5.1 Select “Rectify” menu in drop-down menu in georeferencing tools.

the “Save As window” appears.

5.2 The output location will default to Default.gdb in the ArcGIS folder on the C:\ drive. 
Change that to the location where you want your data to be stored (e.g., c:\temp\gisdata). 
Keep the name amhersttopo1 and press the “Save” button. The image will be rectified [tif 
format] as well as “world-header” file [twf] will be created. Be sure that you keep/store 
these files together, as “world-header” files contain the projection information associated 
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with the new TIFF file. When working with Tiff rasters, ArcMap and ArcCatalog looks 
for these .twf world files.  

5.3 Close the map with the jpg (add a new map). Click over to ArcCatalog and you 
should see both the jpg and tiff raster files. Add rectified image to the project in ArcMap. 
Check the properties of the layer. What coordinate system does the image have? Use 
the “measurement” tool to measure some distances on the rectified image. Try the same 
on the paper map/scanned image. The values of distances should be the same. 
More information about Georeferencing/Rectifying can be found in ArcGIS online help.
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6 Appendix A. Scanned Image, map information

Control Point #2
703000E
4699000N

Control Point #3
705000E
4699000N

Control Point #1
703000E
4695000N

Control Point #4
705000E
4695000N
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7 Appendix B. Comparison of different image formats.
What is the difference between TIFF files and JPG files?

They are different ways of storing images in a pixel or raster format. Some important 

information:

Pixels – picture image element

Image resolution – number of pixels in a digital image (higher 
resolution, better quality)

Monochrome image – each pixel is stored as a single bit (1 or a 0).
                        A 640x480 monochrome image requires 37.5 KB of storage.

Gray-scale images – each pixel is stored as a number between 0 and 
255. A 640x480 gray scale image requires over 300KB of storage.

8-bit color images – Each pixel is represented by 1 byte. 256 possible 
colors out of the millions of colors possible. A 640 x 480 24-bit color 
image requires 307.2 KB of storage. Requires a color lookup table.

24-bit color images – Each pixel is represented by 3 bytes (e.g., 
RGB). 256x256x256 possible combined colors (16,777,216). A 640 x 
480 24-bit color image requires 921.6 KB of storage.

Some standard system-independent formats

GIF – Graphics Interchange Format
Designed initially to transmit graphical images over phone lines via                     
modems. 8-bit representation (256 colors). Suitable for images with few distinctive 
colors. GIF works well with images that have only a few colors such as line drawings.

JPG – Joint Photographics Experts Group
Compresses either full-color or grey-scale images. Works well with photographs, 
artwork, etc., but not well with lettering, simple cartoons, or line drawings. JPEG 
compression takes advantage of the limitations in human eyesight to make the image 
represented smaller without compromising what we see as humans. Basic jpeg stores 
images with 8 bits per color (24 bits for RGB, 8 bits for grey scale).

TIFF – Tagged Image File format
Stores many types of images (monochrome, gray scale, 8bit and 24 bit RGB)
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Online Digitizing and Editing of GIS Layers 
(On-Screen or “Head’s Up” Digitizing)

 
2011 Charlie Schweik, Alexander Stepanov, Maria Fernandez, Lara Aniskoff
Note: This work is licensed under the Creative Commons Attribution-

NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this license, visit 
http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of 
Geographic Information (MassGIS), Commonwealth of Massachusetts, 

Information Technology Division (www.mass.gov/mgis). Any further use of 
these datasets in other situations should acknowledge this organization.

1. Introduction

The purpose of this exercise is to demonstrate how to do create a GIS data layer using online or 
“head’s up” digitizing. In this exercise, you will use the following data for the Town of Amherst 
that covers some area of the UMass campus. 

 town’s boundary; 
 tiger road network; and 
 a digital orthophoto from 1997, 

What is a digital orthophoto? It is a completely rectified copy of an original photograph. 
All variations in scale and displacements, due to relief, have been eliminated, hence the 
name ortho (correct) photography. Orthorphoto and orthophoto map are synonymous, an 
orthophoto is, very simply, a photo map.

To get familiar with the online digitizing procedure, you will create the following data layers: a 
parking lots layer, a campus buildings layer and a sidewalk layer. Please refer to Appendix A for 
more detailed layer specification. 

There are several ways how to enter data into GIS system. One older method is to copy data 
from a paper map placed on a digitizing table or, more commonly, using “on-screen digitizing”  
from a background scanned and georeferenced raster image (see our previous exercise on 
georeferencing a paper map).  To conduct on-screen digitizing, it’s necessary to open some 
existing data layer/coverage/image with needed information. This layer is used to trace features 
of interest with mouse. After adding the spatial features to a geodataset it’s necessary also to add 
attribute information to the associated “feature attribute table.” Recall that GIS layer is a 
combination of spatial information (map) and corresponding database or “attribute” information 
(table) about the spatial features.  

2. Add the Existing Data for Amherst 
2.1 Copy and unzip the digitizing dataset from the course website (under today’s date) to your 
c:\temp\gisdata directory. (Note: this is a large dataset – it will take a bit of time)

http://creativecommons.org/licenses/by-nc-sa/3.0/
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2.2 In ArcCatalog, check each layer (tig8 – roads line vector layer; towns polygon vector layer, 
and the 1_117902 raster aerial photo) for projection information (right click properties). One of 
these is missing its spatial reference/projection information. It should be State Plane, NAD 1983 
Massachusetts, units meters. 

2.3 Add the following datasets to ArcMap: towns, tig8 and 1_117902.tif (build pyramids for this 
layer). In the table of contents, rename these layers as “Town boundaries” for layer towns, 
“road network” for layer tig8 and “Amherst 1m Orthophoto” for the image. [Right click 
on the layer in the table of contents, click properties, click the general tab, change the layer 
name.]

2.4 Locate the data layers in the following order (from top to bottom of table of contents): 
“road network”, “Amherst Orthophoto” and “town’s boundary”.

2.5 Change the symbology of the layers by double-clicking on the icon under the layer name in 
the table of contents. For the “road network,” set the outline color to red and set the fill color 
to “no color.” With the “no color” chosen, you will be able to see orthophoto underneath of 
the road network. Zoom in to these layers. Do the road coverage and roads on the 
orthophoto image match exactly? What can you say about the spatial accuracy of the 
tiger road network? 

2.6 Set map extent/zoom in such way that you able to see all of the Amherst town area. 
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We will now digitize building footprints (polygon), parking lot center points (point), and 
sidewalks (lines) of parts of the UMass campus. First, we need to create new data layer such that 
this layer has the same projection information as our road network layer and it will consist of 
polygon features. 

2.7 Get some spatial domain information that you will need to create the new layer.

What we are about to do is create a new feature class for digitizing building “footprints.” 
Before we create the new layer, you need to check the spatial domain coordinates for the area 
you will be digitizing. Probably the safest thing to do is get the x/y corner points for the 
broadest extent of background layers. In this case, that would be the “Towns” layer.

In ArcCatalog, right click on the “Towns” layer. Choose properties.
Under the “Projection and Extent” tab, review the Extent information.
Write down the x min, x max, y min and y max. When I did this, I got the following values:
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Xmin: 33861.26171875
Ymin: 777514.3125
Xmax: 330846.09375
Ymax: 959747.4375

NOTE: IN THE FUTURE, THE VALUES ABOVE WILL CHANGE DEPENDING 
ONTHE FEATURE CLASS YOU ARE USING FOR A BACKGROUND. 

We will use these values to define the spatial domain of the new feature class (buildings 
layer) you are about to create.

In other words, this “frames the coordinate space” that you will do your new digitizing in. 
We’ve decided to choose the broadest area of the three layers – the full extent of 
Massachusetts. 

3. Create a New Data Layer of Building Footprints
3.1 Click over to ArcCatalog and make sure you are in your work location [C:\TEMP\gisdata]

3.2 Select a destination folder on left-side bar (e.g., C:\temp\gisdata) and click right-button. In 
the pop-up menu select “New” > “File Geodatabase” 

Note that there are two options: File Geodatabase and Personal Geodatabase. Personal 
Geodatabases (there are also enterprise-level geodatabases, sometimes referred to as an ArcSDE 
database.

For more information on the differences, see 
http://proceedings.esri.com/library/userconf/pug07/papers/workshops/file-gdb.pdf

http://proceedings.esri.com/library/userconf/pug07/papers/workshops/file-gdb.pdf
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See also: http://www.esri.com/news/podcasts/transcripts/typesofgeodatabasesatarcgis92.pdf

3.3 Name this geodatabase “umasscampus” and store it as a “File Geodatabase”

Note: On Windows, the file geodatabase is stored in a folder called “umasscampus.gdb”. 
Personal geodatabases, on the other hand, are stored using Microsoft Access (e.g., 
umasscampus.mdb). 

Either way, this will be a geodatabase (the new database storage for ArcGIS) that will 
keep our three new layers: parking lots coverage, building coverage and sidewalk 
coverage.

File geodatabases are more efficient in storage space and can store more data than 
personal geodatabases.

3.3 Next create the polygon coverage for the buildings inside this new dataset. Select 
“umasscampus.mdb” and click right button to invoke context menu. Then select “New” > 
“Feature Class”.

NOTE: 
“Feature class” – One layer. A shape file could be considered a feature class.
“Feature dataset” – Multiple, related feature classes that you don’t want separated (e.g., water 
lines and water valves)

3.4 Specify “Buildings” for the name in the “New Feature Class” dialog window.  

http://www.esri.com/news/podcasts/transcripts/typesofgeodatabasesatarcgis92.pdf
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AND THIS STEP IS CRUCIAL! Choose the type of feature to be stored in this feature class 
(e.g., polygons, lines, points). Note: The difference between point and multipoint is that 
multipoint has more than 1 point but only one row of attribute data.

For this exercise, choose “Polygon Features”. Click “Next.”

The select coordinate system window will appear

Select  Projected Coordinate System > State Plane > NAD 1983 (Meters) > NAD 1983 
StatePlane Massachusetts FIPS 2001(USFeet). Hit Next.

Leave default X/Y tolerances. Hit Next. 

3.5 The following dialog box should appear:
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3.7 Add New Database (Attribute) Fields
Add the following fields to the attribute table: BLDNAME, NUMFLOORS and DEPARTMENT 
by typing in a blank row. The figure below illustrates this step:

Note that for each field there are “field properties” that you can change. For example, text fields 
by default are 50 characters long. 

Click “finish”. You just created new coverage in the geodatabase “umasscampus”, with the 
same projection settings as the road network coverage in this project.  You defined the database 
structure for this coverage also. So far, this coverage is empty. Now it’s time to add some spatial 
and descriptive information to it. 

Repeat steps 3.3 – 3.6 to add the other feature classes (“Parking” and “Sidewalks”) to the 
geodatabase.  Define the Parking feature class as a point feature type and add a new text field 
called “LOTNUMBER” to the attribute table.  Define the Sidewalks as a line feature type and 
add attributes “DATE_LAST_REPAIRED”  (Data Type – Date) and “MATERIAL” (Date Type 
– Text). 

4. Adding New Spatial Features (Polygons) to the layer

Enter fields names here as 
well as their data types.
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4.1 In ArcMap, use the “Add data” icon and navigate to the UMasscampus.gdb. Double 
click so the Buildings and Sidewalk layers are displayed. Choose the buildings layer.

4.2 The Building layer will be added to the table of contents. Set an appropriate color 
scheme for this layer. Make sure this is the active layer and that it resides ABOVE 
the image in the table of contents (click once on it to select it in the TOC).

4.3 Be sure that you have “Editor” menu on your screen. If not, click on the “Editor 
Toolbar” button .  Click the down arrow next to “Editor” and select Start Editing. 
A window will appear that requires you to specify what “layer or workspace to edit”. 
This is displaying the different layers in our work folder – a file geodatabase (the one 
we want, with buildings) and an older arcinfo workspace that has tig 8 and towns 
polygon layers. Choose the buildings option (Note: this doesn’t totally coincide with 
the below snapshot). 

4.4 To initiate editing session click “Editor > Start Editing”. Select the “Buildings” 
layer when the start editing window appears. Click off the roads layer so that just the 
orthophoto is displayed.

4.5 Be sure that task is set as “Create New Feature” and Target as “Building” coverage. 
That is, click on the “buildings” option under the “Create Features” window on the right 
side of the ArcMap screen. 

4.6 Zoom in the layers that you will be able to see some buildings clearly. Let’s digitize 
first the Mullin’s Center.

4.5 To begin heads-up digitizing choose “Polygon” from the Construction Tools.   
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(Note that there are other editing tools on the “create new feature” menu that we will not talk 
about today.) 

When you digitize you will make errors. You can undo mistakes with the “undo” button on 
the main arcmap toolbar. 

4.7. Now move cursor to the building boundary and press left button, move/trace cursor along 
the building footprint and press left mouse button periodically. To complete the polygon press 
“F2” or make a double click with left button.

After you are done, turn off the “create new feature” mouse by double clicking. The light blue 
boundary around the feature you just digitized means that it is still “selected” and active.

4.8 Click on the “Attributes” button (the little spreadsheet-like icon on the right side of the 
editor toolbar) to invoke attribute data form. Fill out attribute information.
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4.9 Hit enter on the last attribute information and close the attributes window. Repeat steps 4.6-
4.8 to add some polygons representing UMass Campus Buildings. 

4.10 Periodically, Press “Editor > Stop Editing” to save your data and quit from editing 
mode. Remember; do save your data often!!! If you don’t see your polygons, it is probably 
because your new feature class is below the orthophoto in the table of contents.

5. Editing Features
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5.1 Suppose you need to change the shape of the polygon. To do it, press “Edit Vertices” 
button on the EditTools menu .

5.2 Navigate cursor over the polygon and double-click on it. The contour line with 
vertices will appear. You can move/change position of vertices if you locate cursor over 
the vertex.

5.3. Press left button (don’t release it) and move vertex to a new location. Double click to 
stop editing.

5.4 Save your data after editing (editor drop down list, save edits). 

5.5. Now try digitizing the other layers (parking-points and sidewalks-lines). You’ll need 
to add the parking and sidewalk layers in from ArcCatalog or using the “Add layer” 
function.

6. Summary

In this lab, we learned how to:
- Create new layers using ArcCatalog and import an existing projection from a layer we 

already had in our existing GIS
- We learned how to work with ArcGIS’ “geodatabase” structure
- We learned how to add fields to the new layer’s attribute table
- We learned how to do “head’s up” or on-screen digitizing using a background image and 

how to edit and change the shape of existing features. NOTE: in this exercise we used an 
orthophoto, but we could use any scanned and georectified map as a background to 
digitize features from. (For instance, a scanned toposheet).

- We learned how to add attribute data to the feature’s record in the feature attribute table

It should be noted that careful digitizing and editing of layers is an important part of GIS 
creation, and that in reality this process can take a long time and require tedious editing. Note 
also that ArcInfo 9 and ArcEditor 9 are the more advanced tools for this kind of work. If you 
plan to create lots of new layers, you should consider upgrading to one of those software.

Finally and importantly, this lab has only touched the surface of online digitizing. If you think 
you will be doing a project where you will be doing a lot of digitizing, you should probably read 
up more on this. See me if you want to borrow a book that has several chapters on it.

Contour line with vertices. 
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Appendix A
Campus Building Coverage [POLYGONS]

Field Name Field Type Description
BLDNAME Text Name of Building
NUMFLOORS Short Integer / text Number of floors
DEPARTMENTS Text Department(s) located in the building
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Exercise In Overlaying Secondary Data on an Existing GIS Layer:
“On the Fly Projection” and “Projection Conversions” 

 
2011 Charlie Schweik, Maria Fernandez, Maili Page

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic Information 
(MassGIS), Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). 

Any further use of these datasets in other situations should acknowledge this organization.

Overview

This exercise goes over three things:

1) On the fly projections 
2) Permanent projection conversions
3) ArcMap and layer backing up

1. Projection conversions

You may often find yourself in the situation where you want to develop your own 
basemap to generate some GIS layers, and then also want to add GIS layers that have 
been developed by someone else. And these other layers are in a different projection that 
what you developed your layer in. 

This lab gives you some information on how map projection conversions are done in 
ArcGIS. It uses a georeferenced USGS topomap developed through the methods in the 
earlier “georeferencing a scanned basemap” lab  (projected to UTM NAD27) and data 
downloaded from MassGIS (Projected in State Plane NAD83). So this problem can be a 
common one! 

This lab is also designed to give you some practice in file management.

ARCGIS’ On The Fly Projecting

1. CLEAN UP C:/TEMP/GISDATA. In windows explorer or my computer, 
navigate to c:\temp\gisdata and delete all our old files. I want an empty 
c:/temp/gisdata folder to begin this class.

2. Copy the “projection.zip” file from the class website to c:\temp\gisdata. 
Unzip the files. 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Two files: (1) Scanned and georeferenced topo sheet for Amherst 
(Rectifyamhersttopo.tif) and (2) Amherst “tiger roads” shapefile 
(tig8r1.shp).

3. Open up ArcCatalog. Navigate to your C:temp\gisdata drive folder. If your folder 
is not there, use the “refresh” function (right click and hit refresh or hit F5)

4. Recall that we georeferenced the topo map using the projection information that 
came on metadata on the map (Appendix 1). 

What projection is the “RectifyAmherstTopo” raster image in? How can you 
find out? 

Answer: In ArcCatalog, right click on the RectifyAmherstTopo and 
choose “Properties”. Scroll down to “Spatial Reference.” Answer is UTM 
Zone 18N, North American Datum 1927.

Why does ArcCatalog know the projection? What file is it reading to get that 
information?

If you don’t know the answer, go to Windows explorer, navigate to your 
c:\temp\gisdata folder, make sure view details is on, and look for files 
associated with the RectifyAmherstTopo file. 

The answer is because there is an associated  “TFW” file – or “tiff world 
file” that was created when the georeferencing was done. This contains the 
projection information. ArcCatalog looks for this and therefore knows the 
projection of the tiff raster toposheet.

5. Go back to ArcCatalog and look at the metadata for the Amherst tiger roads 
(Tig8r1) shapefile layer that I downloaded from MassGIS. Is there projection 
information there? 

How do you check this? Right click on the shape file. Properties. XY 
Coordinate system tab. If it says “unknown” it means it hasn’t been set. 

So the answer is No… we have to re-enter it using what we know about 
the projection of MassGIS data.

What projection is MassGIS data in? Massachusetts Stateplane 
Mainland Zone Coordinate System, Datum NAD83, Meters

Assign the projection information to the Tig8r1 shape file in ArcCatalog. 
By now you should know how to do this. 
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(right click, properties, geometry, spatial reference, “…” button, select, 
projected coordinate systems, state plane, NAD83, Massachusetts 
mainland, add, OK.

SO HERE’S THE MAIN ISSUE:

We have two layers using two different projections: a topomap raster file in 
UTM Zone 18N NAD27 projection, and a roads shape file in State Plane, 
Mass Mainland NAD83 projection. 

ArcMap is smart enough to help them overlay correctly, using a technique 
called “Projection on the Fly.” 

6. Open ArcMap, start a new map.

7. Drag the rectifyamhersttopo image to the table of contents. 

8. Drag the Tig8r1 shape file over to the table of contents and place it ABOVE the 
tiff file so that it can be seen. 

You will get a “Geographic Coordinates System Warning” message – this is 
reminding you that the two systems utilize different projections/coordinate 
systems. 

Change the color of the roads to red or some other color of your preference that 
you can see easily. 

How well do things line up? Zoom in to an area and assess the accuracy 
of the roads in both layers. 

Zoom in to north Amherst. Make tigr1 active in table of contents. Use the 
identification tool (the little “i”) to point to the line near Sunderland road 
in the top left corner of the topomap. Look at the attributes. Is it 
Sunderland road?

WHY do they line up – at least somewhat close given they are in 
different projections????? 

ArcMap automatically tries to implement on-the-fly transformations. 

This means that if two feature classes are not only stored in different 
projections, but also in different datums, the data will be transformed to be 
displayed in the projection of the data frame.” 

So ArcMap is converting the projection of the topomap to the projection 
of the Tiger file “on the fly.” 
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Part of the reason they still don’t line up well is because the Tiger roads 
files from census probably have some errors in them. Brings us back to the 
issue of ERROR again in GIS data.  But Tiger files are useful for address 
geocoding which we will soon see. 

On-the-fly projections causes the computer to do extra work though, 
so often you want to PERMANENTLY CHANGE THE 
PROJECTION of a layer to the accepted projection for your GIS. 

2.  Converting a Layer to Another Projection Permanently – in this case Converting 
from STATE PLANE NAD83 TO UTM ZONE 18N NAD27 (something useful for 
you to know)

In some instances, on the fly projection may not be accurate enough for I’ve read that its 
mathematical computations can be limited. In some instances you may rather convert, 
permanently a layer from one projection into another. 

For instance, for people using MassGIS data and USGS data, you may find yourself 
wanting to convert MassGIS’ State Plane NAD83 data to UTM NAD27 projection found 
on traditional toposheets.

How might this be accomplished? 

In ArcToolbox, under Data Management Tools à Projections and Transformations 
à Feature (because we are converting the shapefile; if we wanted to convert the raster 
image to State Plane, we’d use Raster instead of Feature) à Project
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I selected the tig8r1 shapefile. 

Next, I specified the output file – tig8r1_Project.shp

Next, I selected the coordinate system I wanted it converted to (UTM, NAD27, Zone 
18N like the USGS topomap)

You’ll notice that the next step is listed as ‘optional’. However, when I entered in the 
coordinate system that I wanted to convert the roads layer to, a drop down arrow 
appeared next to the field as well as a little green dot to indicate that the field is required. 
This is because the program needs to not only convert the projection, but also the datum 
used. This requires a “geographic transformation.”

In other words, not only do we need to change projections, but we need to change the 
model of the 3-D earth – the datum used. 
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Last, I select the Geographic Transformation box

You need to press the little down arrow to the right to display the list of possible 
“transformation” procedures that could be used. One is for Alaska, the second, 
NADCON stands for “North American Datum Conversion.” Choose this second 
one. 

 NAD_1927_To_NAD_1983_NADCON

The output of this last step produced a file that I named “tig8r1_Project.shp” that was in 
the same projection as the georeferenced topomap (UTM NAD27) and appears to line up 
exactly with the on-the-fly projection of the original tiger file data. This provides some 
level of confidence that the on-the-fly is projecting pretty well. 

In the figure below, both the on-the-fly Tig8r1 file and the reprojected 
“tig8r1_Project.shp” are displayed and overlay exactly the same. 

But after a few moments to allow your computer to process the transformation, go back 
to ArcCatalog and look at the new file’s projection information (properties). The original 
Tig8r1 is in State Plane NAD1983 and the tig8r1_Project.shp is in UTM NAD27.
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2. More on File Management – Backing up and recovering files

I want to make sure you all completely understand how to back up files given you are 
now working on your projects. We addressed this earlier when we talked about 
“Making ArcMap portable”…

1. Go back to ArcMap. You should have a map open, with the topo and the tig8r1 
shape file being projected on the fly over it. 

2. Make the map “portable.” (file, map document properties, click next to 
“Pathnames:” “Store relative path names”). Click OK.  

3. Save and close the ArcMap file. Save it as c:\temp\gisdata\yourfirstname
4. Close ArcMap
5. Go to Windows Explorer and navigate to the c:\temp\gisdata folder.
6. What files are associated with what? What is the “ESRI ArcMap document”?

a. This is the ArcMap file that contains all the links to the different layers, 
and your Table of Contents information. Remember, the ArcMap 
document is separate from the data layer files. So you need to back up all 
of it (ArcMap document AND the data). I find the best way to do this is 
back up an entire folder (if your back up drive can store all the data – 
sometimes datasets can be really large). 

7. Rename the gisdata folder to “yourlasname1”
8. In ArcCatalog, copy this folder to another drive (this could be an external hard 

drive) or at UMass maybe your “U:Drive”, or a flash stick. For relative 
addressing, you want to copy the entire folder. 

9. For people doing this in a UMass classroom, switch computers with your 
neighbor to simulate you moving to another computer. (For people who might be 
doing this exercise online, you should try to “recover” your folder from the 
backup device to perhaps another location on your computer.)

10. Copy the folder from your storage location to the c:/temp directory on this new 
computer.

11. In ArcCatalog, navigate to that folder
12. Open up the “yourfirstname”  ArcMap document
13. Do the layers show up or do you see the little red exclamation marks? I hope not! 

In you do, something went wrong – the ArcMap document can’t find your 
datasets. If you don’t have red exclamation marks and can see your datasets in 
ArcMap, then your backup worked perfectly!
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Appendix A: Topomap metadata
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Summary of important GPS concepts

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

INTRODUCTION

In this exercise we (1) review some important concepts related to how Global Positioning 
Systems (GPS) work; (2) review the Garmin GPS devices that our department has to use 
in the field; and (3) we undertake a “Geocaching” field exercise. Geocaching is a game 
that uses GPS’ to location “caches” (see Geocaching.com). But it also is a technique that 
can be useful in searching for features in the natural environment that you can see on an 
aerial photograph.  

SUMMARY OF GPS CONCEPTS

1. In general, how does GPS work?

GPS uses the distances of the hand-held to 3 or 4 satellites to locate itself 
on the Earth. 

By getting the distances to four satellites you can locate where you are in 
3-dimensional space.

2. In general, how are those distances calculated?

Once a GPS receiver has fresh almanac (satellite health data) and 
ephemeris (satellite orbit) data (which it downloads from the satellites 
when you turn it on), it knows the actual locations of the visible GPS 
satellites. But this information is of no value unless the receiver also 
knows the distance to each of these satellites. 

The distance is determined by measuring how long it takes for the 
radio signals to reach the receiver from each visible satellite. 

The satellites each have highly accurate atomic clocks, and the receivers 
have less accurate crystal controlled clocks.

Supposing that the system is set up so that at exactly 1 p.m. each day, a 
satellite and your receiver start to play U2’s A Beautiful Day. The satellite 
transmits the U2 song on radio waves that travel at the speed of light. 

Your receiver receives the signal and compares it to the version it is 
playing itself. 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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If both clocks were perfectly synchronized and accurate, the music from 
the satellite would be slightly behind your receiver version, since it took 
some time for the signal to reach you. 

The amount of time you need to shift your version back to be in sync 
with the satellite version would be the travel time from the satellite to 
you. 

Knowing the speed of light (about 186,000 miles per second or 300,000 
kilometers per second) makes it easy to compute the distance to the 
satellite using the following formula:

Distance = travel time of a radio signal X speed of light

3. What is generally the best accuracy you can get with a “standard” or low end GPS 
receiver?

10 meters (30 feet)

4. What types of things cause the error in the signal?

 Atmospheric interference
 Small errors between the clocks of the satellites
 Multipath error – stronger signal bouncing off something nearby
 Satellite positional error (called Ephemeris error)
 Error caused by your GPS unit (its quality – e.g., number of channels your 

receiver has)

5. What is differential correction? How does it work?

Base-station at a known location that “talks” to the satellites at the same 
time you do. But it knows where it is on the earth so it can calculate the 
error any combination of 4 satellites are giving at any point in time.

Differential correction is a process where your GPS location is “shifted” 
and made more accurate using the error that the base station knows about. 

With the GPS’ we are using, this can get to about 3 meters accuracy (~12 
feet).

6. What is the Wide Area Augmentation System (WAAS)?

It is one system for differential correction that some receivers have 
embedded within them. Our Garmin 72s have this capability.
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Garmin 72 GPS procedure in preparation for Geocaching

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

INTRODUCTION

In this exercise we will check important settings on the Garmin 72 GPS’ our department 
provides and then your team will try and navigate and locate the Geocache I have hidden 
somewhere on campus. {Note: the actual Geocache location will be provided separately.}
 

GARMIN GPS 72 
Steps for the geocaching exercise

Basically for any GPS geocaching exercise you need to 

(1) check various settings of the device (including and especially the datum it is set to); 
(2) enter the “waypoint” you want to search for; and 
(3) start navigating to it. 

And whenever you use GPS for any kind of GIS work, you need to know what datum it is 
collecting in. You also want to know its general accuracy, and whether it is using differential 
correction technology like WAAS. 

1. Turn on the device: (RED LIGHT button)
2. A warning appears saying Garmin is not responsible if you walk off a cliff following this 

device. Press the PAGE button.
3. The screen that appears is the “GPS information” page. It has “elevation” on the top left, 

Accuracy on the top right. And the coordinate system it is displaying at the bottom. 

1. Check setup parameters

The coordinates I am giving you are in Lat/Long (degrees decimal) and WGS84 datum.

Every GPS should have some information somewhere on its setup configuration. To get to 
setup on this Garmin:

1. Press MENU TWICE to get to the menu screen.
2. Press the ROCKER key (the round key in the middle) to scroll down to the SETUP 

option on the main menu. You can hit the ROCKER key on whatever side you want 
to move the cursor on the screen.

3. Press ENTER

http://creativecommons.org/licenses/by-nc-sa/3.0/
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4. On the GENERAL tab, make sure WAAS is set to ENABLED. If it is set to 
DISABLED, use the ROCKER key to scroll down to it, Press ENTER, scroll to 
ENABLED and press the ENTER key.

WAAS is a form of “differential correction” – see my handout the other day on 
this.

5. Use the ROCKER key to get the GENERAL TAB highlighted again. Scroll using the 
ROCKER right to the TIME TAB.

6. Check to make sure it says time zone – EASTERN and that the date and time are 
correct. Use the ROCKER to scroll up to the TIME TAB. 

7. Use the ROCKER to go to the UNITS TAB. Check what units for depth it is 
providing (feet or meters) so you know. 

8. ROCKER up to the UNITS TAB and move one more to the right to the LOCATION 
TAB. 

9. Check the LOCATION FORMAT the GPS is set to use. 

a. Use the ROCKER and scroll to the Location Format field. Press ENTER. 
Use the ROCKER to scroll down to Long/Lat hddd.ddddd format. (degrees 
decimal)

b. Press ENTER. 
c. The datum we want in WGS84. (Note: USGS maps use NAD27. So if you 

were going to try and match up to that, you’d use NAD27 CONUS 
(Continental US)). 

10. Press PAGE to return to the GPS information page.

2. Enter in the navigation “waypoint”

1. We now need to tell the GPS the point we want to find (the point I give you). 
2. To create a waypoint:

a. Hold the ENTER key down for a long time. This will invoke the “MARK” 
function. The Mark Waypoint screen will appear.

b. ROCKER down to the number field (it might read 001) and hit ENTER. The 
first digit should be highlighted. Use the ROCKER keys to change the 
numbers to the word “CA1” (for cache #1) – to name the point you are 
looking for. When done, press ENTER. 

ROCKER down to the LOCATION field and press ENTER. It should have a 
UTM  coordinate listed (the one it has just recorded as we stand there). 

Carefully enter the numbers I have provided for you on the PAGE I 
hand out. 

Make sure “show name on maps” is checked on.

c. Move to OK and press ENTER.
d. You now should have a waypoint CA1 to navigate to.

3. Navigate to find the Cache

1. Clear the TRACK log
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a. Press the MENU key twice to get the menu screen
b. Highlight TRACKS and then press the ENTER key
c. Highlight CLEAR button and press the ENTER key
d. Highlight the YES button and press the ENTER key
e. Press the PAGE key until the Map Page is displayed.

2. Press the GOTO key
3. With Waypoint highlighted, press ENTER
4. Highlight the waypoint we created -- “CA1” and press ENTER
5. Use the PAGE key to toggle to the map display. 
6. As you walk (you must walk around to make this work – don’t stand in one place) 

the pointer will point in the direction you need to go to find the waypoint. If you 
zoom out, you should see the straight line to the destination, and as you walk you 
should see a dotted track line that represents the path you are taking. 

7. After you find the cache, write down a reading of your GPS while you stand near it. 
Bring that reading to Thursday’s class.

Use the ZOOM OUT and IN buttons to help you get a view of the line you are tracing. 
Good luck finding the cache! If you find it, please enjoy a little reward!

BRING THE GPS BACK TO ME AT THE END OF THE EXERCISE!
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Mapping locations using an Event Theme
(Such as after GPS fieldwork)

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic 
Information (MassGIS), Commonwealth of Massachusetts, Information Technology 
Division (www.mass.gov/mgis). Any further use of these datasets in other situations 

should acknowledge this organization

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

To prepare for this exercise, download the class exercise data from the class website for 
today’s class date to your c:\temp\gisdata folder.

INTRODUCTION

The objective of this exercise is to show you how you can map GPS locations using a 
simple “event theme.” I teach this technique because I don’t know what kind of GPS you 
might use in the future. This technique is a manual data entry technique (rather than an 
easier technique of downloading GPS data directly from a GPS). So it is more useful for 
mapping a smaller set of point locations than it would be for mapping “tracks” of where 
you might have walked with a GPS. But I show this technique because it is a generic 
technique that can be used with all GPS units. 

[Note: I have another exercise that describes how you can use a software called 
“DNRGarmin” for Garmin GPS units. This is nice to use if (a) you have a Garmin GPS; 
and (b) you have collected line or polygon data. DNRGarmin is capable, for example, of 
downloading directly as an ESRI Shapefile.]

But back to the issue of manually entering GPS data as an “event theme”.

Develop a point layer for the known survey coordinate location as an “event theme”

On the University of Massachusetts campus, we have a known surveyed point that exists 
in a field off of University drive in a field right across the street from the UMass Football 
stadium. One of the points we will enter below is the location of this survey marker. I am 
also providing you below, GPS readings I took standing on top of this marker. Those 
readings have some GPS error in them. So you will be mapping the GPS location and 3 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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other points (GPS readings) as I stood on this marker so you can see the kind of error 
GPS can provide.  

1. To start a question – and you should know this by heart by now – following my 
other exercises. What projection MassGIS data is stored in? 

Answer: Massachusetts State Plane. Lambert Conformal Conic projection, 
NAD83 (datum), units – meters. 

2. Open ArcCatalog. Check the projection information for the 1_117902 aerial photo 
of the UMass campus. Does it need to be set? If so, you should know by now how 
to set it to the projection above. 

3. Start ArcMap. Drag the 1_117902 image over to the Table of Contents in 
ArcMap. Look at the projection coordinates in the bottom right of the ArcMap 
screen as you move the mouse cursor around. 

These are State Plane coordinates for MA (e.g., 112404, 906191). 

The reason it says “unknown units” is because we have not set the “Data Frame 
Properties” for the Map/Display units. 

View menu, Data Frame Properties, General tab, Units – Map. Change Map 
units from Unknown to “Meters” and also Display from Unknown to Meters.  
Click OK. Meters should appear next to the coordinates in the lower right 
region of the ArcMap window. 

4. Zoom into the UMass football field area. To do this, use the “Go to XY” tool (it is 
right near the binoculars icon on the zoom toolbar). Enter in the State Plane 
coordinates:

Long: 114826.852 
Lat: 903474.751 

This is a little confusing because we are entering State Plane coordinates – they 
are NOT longitude/Latitude coordinates. (But you could do this with Long/Lat 
coordinates if they were in a format like decimal degrees and had projection on 
the fly on). 

Then click the “Zoom to” icon in the Go to XY menu. This is the little magnify 
glass. A green dot will flash in the location where this survey point exists in the 
field across from the football stadium. 

Close the “Go to X/Y” window.
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Overview of the next steps 

So here’s what today’s exercise is about.  We will be using and “event theme” 
so that you can map locations collected with a GPS.

What we will simulate here is what I did…

1) I want to develop one point that represents the location of the 
actual survey marker (the location that I just provided to you).
 

2) I want to display 4 GPS PREDICTED points that I collected with 
a GPS receiver at this survey marker to see how far off they were 
graphically. (But note I converted these from Long/Lat to State 
Plane coordinates outside of this exercise to make things a little 
easier.)

3) I want to enter in the point you collected with your GPS during 
the geocaching exercise. 

To add an event theme, we need to create a database table to hold the 
coordinates. 

The general steps are:

1) Build a table with easting/northing fields to store your X/Y data. 
There are many ways you can do this, but we will use ArcCatalog 
to do this (Dbase table). 

2) Move the (empty) table to ArcMap and edit the table in ArcMap 
with your GPS data

3) Create an “Event Theme” based on these data

4) Save these X/Y points as a shapefile or feature class in a 
geodatabase 

STEP 1. BUILD A TABLE TO STORE GPS DATA IN USING ARC CATALOG

a) Invoke ArcCatalog
b) Navigate to the folder where you want your table stored (e.g., c:/temp/gisdata).
c) Right-click on folder, New, dBASE table. A new “dbase” table appears, called 

“New_dbase_table.” Dbase is an older, well-established relational database table 
format.
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d) Double click (left mouse button) to open up the “Dbase table properties.” Click on the 
“Fields” tab.

e) Below “field1” you should be able to add two new numeric fields 
Our data is in the following format (State Plane coordinates) --  

Easting: 114826.852 
Northing: 903474.751 

In the first blank field row, type in “Easting”
 
In the “data type” field, click the down arrow and set it to “float,” “precision 9,” 
“scale 3”

Then create a “Northing” field should be “float,” “precision 10,” scale “3”

(Note: A Scale of 3 means 3 digits allowed to the right of the decimal point. This is 
one reason Excel doesn’t work well to do this – it likes to round the right of the 
decimal point. )

Easting and Northing are standard terms you see in GIS, because they are generic for 
some kind of X/Y coordinate system. They can be used to store Long/lat data 
(geographic coordinates) or State Plane, or UTM projections, etc. 

f) Add one new text field called “location” to describe the two different points we will 
enter. The default 50 characters long is fine. Your screen should look like the figure 
below.

(Note: if you did some sort of field survey, it is here where you could add other point 
attribute data that describes what the point is you collected). 
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g) Click OK.

STEP 2. BRING THE NEW, EMPTY TABLE INTO ARCMAP AND ENTER 
DATA

a) The “new_dbase_table” may already be showing up in your ArcMap Table of 
Contents.  If it doesn’t, drag it from ArcCatalog into the TOC.  

Now we want to enter our GPS point locations into the table so that we can map 
them. 

b) To enter new data into this table, you have to “start editing” it (editor toolbar). 
Click on the editor icon (the little pencil with three dots). With the “new dbase table” 
highlighted in the Table of Contents, click on the down arrow of the Editor toolbar 
that appears, and change it to “Start Editing.”

c) Right click on the New_dbase_table in the ArcMap table of contents
d) Choose Open. You’ll see a blank screen like below (except there should be a blank 

white row below the heading row). 
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e) Enter one record or row for the survey sheet point (MAKE SURE YOU TYPE 
THESE POINTS IN CORRECTLY!!!). You may have to widen the table window to 
see the location field.

a. Easting: 114826.852 
b. Northing: 903474.751 
c. Location: “survey marker” 
d. Hit “Enter” after entering your information to save the record.  Do this after 

each record.  Otherwise the record will be deleted when you “Save Edits.”
f) Now enter four more records, one for each of 4 GPS readings I collected while 

standing directly over that survey marker location.
a. Easting: 114833.308;  Northing: 903466.249;  Location: GPS 1
b. Easting: 114834.130; Northing: 903474.357; Location: GPS 2
c. Easting: 114830.678; Northing: 903477.741; Location: GPS 3
d. Easting:  114833.842; Northing: 903474.285; Location: GPS 4

g) Within the Editor tool bar click “Save Edits”
h) Double check that the coordinates were entered correctly. If OK, close the table. 
i) In the editor tool bar, choose: Stop editing
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STEP 3: CREATE AN EVENT THEME USING YOUR NEW DATA

a) Triple check on your new data you entered to make sure the coordinates are correct.  
You now have created a point “event table” that we can map as an “Event Theme.” 
Close the table.

b) Here’s the key part to map these points. Go to File>Add Data>Add XY Data

c) It will provide a list of available tables. The “New_dbase_table” should be listed. 
d) Choose the fields – X is the easting field; Y is the northing field. 

Take a moment to reflect why that is. If you were mapping Lat/Long data, it is 
counterintuitive. Longitude would be the X or easting coordinate… the lines go 
east and west. Latitude would be the Y or Northing. The go north and south. 

e) Edit the coordinate system. ArcMap doesn’t know what coordinate system the 
Access data is in.

f) Select
g) Projected coordinate systems
h) State plane, NAD 1983 (Meters), Massachusetts FIPS 2001 (Meters)
i) Add button
j) OK, OK
k) You should see a new point layer called “New_dbase_table Events” is created in the 

ArcMap table of contents with the five locations. But they may not display well on 
the orthophoto. Zoom in if you can’t see it well. Double-click on the TOC entry to 
change the symbol to a triangle. Click OK. You should see several triangles appear on 
the map.

Note that this layer is displaying the point location values of the table 
in the gpsdata database you created. 
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The point layer you see is not a shape file, a point layer in a 
geodatabase or a coverage. It is an “event theme” stored in the 
ArcMap mxd document. 

STEP 4. SAVE THESE EVENTS AS A SHAPE FILE (OR GEODATABASE 
FEATURE CLASS)

If you wanted to permanently convert these “events” to a point layer, you need to first:

Right click on the GPS event theme layer in the TOC, choose the DATA option, then 
EXPORT. Use the same coordinate system as the layer’s source (in this case State 
Plane, NAD83). Navigate to your project folder (e.g., c:/temp/gisdata). You then need to 
choose either a geodatabase feature class or a shape file.  In this case I selected a shape 
file. 

Zoom into the aerial photo to look at the 4 points. Use the Identify tool (get the layer 
highlighted in the TOC and then choose the little “I” tool). Click on the points to see their 
attribute row. How far are the GPS points from the survey point? (use the measure tool). 

What are the factors that cause this error?
i. atomic clock error between various satellites and the receiver.

ii. The angle of the various configuration of satellites
iii. Predictions made by various combinations of satellites.
iv. Possible reflection of a stronger signal from another location (e.g., 

a rock, the stadium) (multipath error)

Applications where you might need better accuracy (e.g., differential correction), 
include:   - GPS “ground truthing” of satellite image pixels

- Collection of permanent forest plot or animal nest locations
- Mapping of gas lines or trails



68

LET’S REPEAT THE PROCESS FOR OUR GEOCACHING DATA

Let’s do the same process for the Geocaching data from the geocaching class. Note 
that the above I provided the point easting and northings in State Plane. Our 
Geocaching data was collected using what coordinate system and datum?

1. Create a GPS pt table in ArcCatalog
2. Move this table to ArcMap
3. Edit the table and enter in your GPS data from yesterday – where you went 
(make sure Easting is a -72!)
4. Add X/Y – create the event theme. Do you see the point(s) where you 
were? 
5. Export as a shape file. 
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Downloading Data Using DNRGarmin and our Garmin 72 GPS units

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

1. See Charlie and sign out a downloading cable from the GPS toolbox. If you don’t 
have a serial port, sign out the serial-USB converter and the driver CD for 
installation on your computer.

2. Go to the DNRGarmin website 
(http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNR
Garmin.html) and download and install the software on your computer. When 
installed, it will create a new menu in ArcGIS. 

3. Plug in the cable into the serial port of a computer with DNR garmin installed (or 
the USB if you are using the USB-serial adapter). Connect the other end to the 
GPS output port in the back of the GPS. 

4. Start ArcCatalog. Start ArcMap. Get the orthophoto you want to overlay on top of 
in ArcMap.

5. Invoke  the Garmin DNR software. (DNR Garmin menu, Open DNR Garmin). 

6. Turn on the GPS. (On ECO’s Garmin 72’s you have to hit PAGE to get past the 
warning screen.

7. On the DNR Garmin menu, 
a. GPS menu, Autoconnect to GPS. It should identify your GPS on one of 

the “ports”. You should see waypoint data (if you have any on your GPS) 
appear in the bottom part of the screen if it connects correctly. 

b. Go to “file” on DNRGarmin menu. Do “Get projection” to see what 
projection is set. In our case from the GPS exercise, it should be WGS84 
(datum) but NO PROJECTION, since it was collected in Long/Lat. If 
there is a projection listed, change it through the File, Set projection 
options. Important! If you just want Long/Lat, then set the correct 
datum, and then at the bottom of the screen press “None” for 
projection.

8. Choose to download either waypoints, tracks, or routes – depending on what you 
collected.

9. You should see a table open with your data downloaded.
10. File, Save to, Shapefile (or Geodatabase Feature Class), file name and location, 

and output shape (points – waypoints; lines or polygons for tracks)

11. Close DNR Garmin. Turn off GPS. 

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html
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GIS Database Overview

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of 
Geographic Information (MassGIS), Commonwealth of Massachusetts, 

Information Technology Division (www.mass.gov/mgis). Any further use of 
these datasets in other situations should acknowledge this organization.

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

Download the associated exercise dataset from the class website to your working folder (c:\temp 
folder). 

GIS Databases: An Overview
 What is meant by the term “attributes” in a GIS?

o Attributes are the various data items associated with a particular feature.  They are 
stored in “Attribute tables” (rows and columns).  If we had a point layer of hotels 
in a city, what might the “point attribute table” look like?

Important Database terms: 
Attributes - fields in a database table
Primary key - a field that allows you to uniquely identify a record in the database
Relation or Entity - the concept that the table is about
Foreign key - needed for joining tables

Coding Spatial Features in an Attribute Table:
• Identifier codes (set by the GIS software) 

• Unique id, primary key
• Class code

• Internal id code (set by the GIS software)

http://creativecommons.org/licenses/by-nc-sa/3.0/
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• Hardcoded in – internal link between spatial feature and attribute record tied to 
this feature, e.g. <cover>#, <cover>-id

• Topology information 
• User defined id code

• Set by the user and editable by the user
• Established by the user when creating a database
• Other attributes (defined by the analyst) that include any characteristic of that 

unique feature

Example 1:
1) Open ArcMap
2) Create a new map document
3) Add

a) C:\temp\database\towns\arc
(Towns “arc” arcinfo coverage)

b) C:\temp\database\eotroads_117shp 
(Tiger roads shape file)

c) C:\temp\database\lus117a.shp 
(Hadley landuse layer)

d) C:\temp\database\umasscampus.mdb\buildings 
(Mullin’s center, geodatabase format)

Open the TOWNS attribute table and determine what are the identifier, internal ID code and 
topology fields.  

The Identifier field is FID, Internal ID codes are TOWNS# and TOWNS-ID, and the 
Topology related fields are Fnode#, Tonode#, Lpoly#, tpoly# and Length.  **LEAVE 
THE DATA IN THESE FIELDS ALONE**The rest of the fields in this table are “user 
defined” keys (US Census defined keys) or other attribute data.  

Next open the Lus117a attribute table and determine what are the identifier, internal ID code and 
topology fields.  

The Identifier field is FID, Internal ID codes are LUS and LUS_ID, and the Topology 
related fields are Fnode_, Tnode_, Lpoly_ and Rpoly_.  

Now open the Umasscampus.mtb attribute table (Geodatabase), and the Buildings (point layer).  
What is the identifier, internal ID code and topology fields within the Buildings layer?

The Identifier field is ObjectID.  However, the Internal ID and Topology information fields 
don’t exist in the attribute table, the information is hidden.  The data is stored in other tables 
within the umasscampus.mdb, which is an Access database and can be viewed if the database 
is viewed using Microsoft Access.  

How do you think Vector vs. Raster attribute tables differ in design?
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Vector attribute tables have one unique record for each spatial feature (e.g., a road 
segment)
Raster attribute tables have one record for each unique cell value in the raster dataset

Example 2: 
1. In ArcMap add C:\temp\database\moun

a. (digital elevation model, ESRI GRID format)
2. Review its attribute table
3. Can anyone describe what this data represents?

Common database tasks:
a) Select features by attributes (querying)
b) Permanently selecting features 
c) Updating an Attribute for a Feature
d) Adding new fields to an attribute table
e) Creating a new table
f) Graphs
g) Reports

a) Select features by attributes (querying)

Go to the Selection menu > select by attribute (also invoked from the “options menu” in the table 
window.  Choose “eoroads_117”  (roads) as the layer.  Method should be “Create a new 
selection.”  Select where Street_Nam = Mountain Rd (click on “get unique values” to see all 
available roads).
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Click “Apply” (you should see several polygons become highlighted; also note that at the bottom 
of the Map window it states “number of features selected: 2.  Only those attribute table rows that 
satisfy the criteria are displayed, click “Close.”  Open the attribute table, and scroll down. You’ll 
eventually see the selected rows.  Note that this selection will be kept until you “clear selected 
features” in the selection menu.  From the Selection menu,  “Clear selected features” to unselect

Does anyone know what SQL stands for?

Note the other options under the Selection menu, including the interactive selection method. 
We’ll do “Select by location” in a future class.

b) Permanently selecting features for the Table of Contents (querying)
Add data by pulling in another copy of eotroads_117.shp into the table of contents.  Change the 
fill color to yellow to make sure it has loaded ok; put it above the other in the TOC.  

Right click on eotroads_117, properties > Definition query.  

Using the query builder, type in the expression - Street_Num = ‘Rocky Hill Rd.” 
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Click OK.  

You should see only the road segments that satisfy that criteria in the layer (if you click off all 
others).  If it doesn’t look quite right, use the “refresh the active view” button (the two arrows).  
Rename the TOC name to “Rocky Hill Rd” (Properties > General > Layer name or by right-
clicking on the layer name in the TOC >Rename), this is helpful if you want to have options in 
your TOC with various features.  

c) Updating an Attribute for a Feature

Feature attributes often store data that change – the date of last inspection, population figures, or 
tax assessment amounts.  Attribute data stored in an ArcMap table can be updated directly by 
editing the attribute table.  Suppose a street name has a typo in the “eotroads_117” file. 

How do we change it? Go to View > Toolbar > Editor > Start Editing.  Open the table to be 
edited (choose shapefiles).  

Change the street field for a record.  Remember to Save Edits then Stop Editing to close out of 
Editor.  Try to edit a field in the table without doing the “Start Editing” -You will not be able to 
do it.

d) Adding new fields to an attribute table

Suppose you’ve set up a GIS layer, and then later you go and collect new information about each 
feature in that layer.  You’d want to add a new field to the attribute table to store this new data.  
We want to keep track of landuse polygons that have active farms on agriculture land, so open 
attribute table (LUS117a1), then go to Options > Add field.  Name field “Farms” (this will be a 
yes/no text field), set the length, etc.
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Note:  to delete a field you can right click on the top grey cell of the column when viewing the 
open table with and then select “delete field”

e) Creating a new table for storing new data

There may be situations where you want to develop a new table to store field data that you might 
later join to a GIS layer attribute table. For example, imagine that we had a point layer of school 
locations for our state and wanted to enter in a separate table school test performance data 
(MCAS). 
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You could create a table externally, using Microsoft Access or Excel and then bring it in from 
ArcCatalog. Another way is to create it in ArcGIS itself. Recall we did this with the Dbase 
option for the GPS Event Theme exercise.

To do this begin by opening ArcCatalog and create a new personal geodatabase (right click on 
folder > new > personal geodatabase, name it something and store it in your c:\temp\ work 
folder.  

Right click on the new geodatabase in ArcCatalog > New > Table.  
Name the table “default.”  

Enter in new fields for the database table you are building. E.g., Average_MCAS_score, short 
integer, Superintendent la_tname, text, 25 long and Date_of_MCAS_score, date.  Press Finish; 
you will see the new table in the geodatabase.  The geodatabase should appear in your TOC, if 
not drag the table over to the ArcMap TOC.  To enter data into this table, follow the same 
procedure as in part C of this lab.

f) Creating Graphs of Data in Tables

Let’s work again with the eotroads_117.shp roads layer. First clear all currently selected features 

using the “Clear Selected Features” button in the toolbar .  Suppose you want to graph a bar 
chart of the length data.  To do this right clicks on eotroads_117.shp in the table of contents.  
Then open the attribute table and choose Create Graph from the pull down menu.  
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Choose “Vertical Bar” as your Graph Type and “eoroads_117” as the Layer/Table. 

 For Value Field choose a field that you are interested in viewing as a graph.  Use default 
selections for the rest of the fields and hit “Next” to move through the wizard.  Hit “Finish” 
when the graph is displaying your information as you want it to.  The graph will open in ArcGIS 
as a new floating window, you can right-click on the graph to save, print or export the image. 

g) Creating Reports Base on Data in Tables

Using the eotroads_117.shplayer clear all currently selected features, then we will display all the 
street names and their feature ID. Open the attribute table and choose Reports > Create Report 
from the pull down menu.

Choose the Street_Nam and FID fields to be in the report, and hit next.  



78

Grouping levels allows you to group records by a particular field or fields (e.g. group by street).  
We do not want to add any grouping levels, so click “Next”.  Sorting fields allows you to sort 
results by one, two or three fields.  And the Summary Options button allows you to do some 
statistical summaries at the end of the report.  Again, we don’t want to sort or have any Summary 
Options, click “Next.”  The next window allows you to change the layout of the report, leave 
radio button on “Stepped” clicked.  Hit next until you get the option to title your report, and 
name  “Amherst Streets and GIS segment lengths.”  Click “Finish” and the report will open.   

You could export the results to a .pdf, or an ascii file, and you can save the  report structure to a 
report (.rdf) file for later use if you wanted to.
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Joining Database Tables in ArcGIS

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Recall from the previous “joins and relates overview” lecture that ArcMap’s “Join” function is used 
to establish 1:1 or Many-to-1 relationships, and “Relates” are used for 1:many and many:many 
relationships between tables of data.

We’ll do two exercises today: 

1) JOINING: Symbolize a layer of landuse polygons for Hadley with a table of legend 
information (a Many polygons such as forest stands have the same 1 row of legend 
information – “forest” or a Many:1 relationship exists)  - an example of a JOIN

2) RELATING information on forest stands that have undergone one or more “burning 
experiments or treatments” – a one polygon has many treatments relationship (1:Many) 

- Clean up the C:/temp/gisdata folder on your computer.
- Download the exercise data for today from the course website and unzip it to c:/temp/gisdata

JOINING EXERCISE

For learning how to join tables and do more table processing, we’ll once again use MassGIS 
data. In this exercise, we will create a GIS layer of landuse polygons for Hadley. To create a 
legend that describes what different polygons are, will require additional table processing.

1. After unzipping the joindata.zip file, you should find the Lus117p1.shp (Landuse for 
Hadley - polygon layer), along with the MassGIS metadata files for this layer.  I’ve already 
defined the spatial reference information for these files to save class time.

2. Start ArcMap
3. Add c:/temp/gisdata/joindata/lus117p1 (the Hadley landuse polygon layer) 
4. Change the table of contents entry from “lus117p1” to “Hadley landuse” (do you 

remember how?)
5. Each polygon represents some type of landuse. Can you figure out from this what 

each represent? 

 Open up the attribute table for the Hadley landuse layer
 What fields might represent the landuse categories? How could you 

find this out? 
 Recall that MassGIS used to store its metadata in .dbf files when you 

download and extract them from the zipped metadata file. They changed 
that to using XML just this year. So in this case the metadata is a zipped file 
“lusmd.exe.” I’ve unzipped it already and it produced a bunch of database 
files stored in the joindata folder. 

 Add the luspc.dbf file to the TOC in ArcMap. Open the table. Look at what 
the codes mean.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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The luspc.dbf file contains the information about what the various 
attribute fields mean. The LU37_code or the LU21_code would be 
useful, because they represent various landuse categories. How do 
they differ?

SO THE ESSENTIAL PROBLEM IS THAT THE HADLEY ATTRIBUTE TABLE 
HAS CODES FOR THE LANDUSE CATEGORIES, BUT DOESN’T CONTAIN 
THE MEANING OF THOSE CODES. THE MEANINGS ARE STORED IN 
LUSPC.DBF. 

Put another way:

The GIS layer attribute table for LUS117p (the Hadley landuses) has a 
MANY polygon – to – 1 legend code relationship with LUSPC.DBF (the 
legend data). For example, multiple there are multiple FOREST polygons, 
but only one “Forest” legend row. 

SINCE THIS IS A MANY:1 RELATIONSHIP, WE NEED TO JOIN THESE TWO 
TABLES TO USE THE MEANINGS AS THE “SYMBOLOGY” IN THE TABLE 
OF CONTENTS OF OUR GIS.

WHAT WE’D LIKE TO SEE IN OUR TABLE OF CONTENTS IS A LIST OF THE 
VARIOUS TYPES OF LANDCOVER AND THEIR ASSOCIATED COLORS.

The task at hand: 
Joining the legend data to the polygon attribute table

1. We need to first figure out the correct fields in each table to set up the join. Review the 
contents of the two tables.

a. In ArcMap, open up the polygon attribute table for the Hadley landuse 
layer. What field contains the codes for landuse?

1. LU37_CODE and LU21_CODE. Let’s use LU21_CODE. 

2. Open the luspc.dbf. What field contains the same corresponding 
codes for the landuse 21 categories? 

IT_VALI. Notice to the right these codes are defined in the 
IT_VALDESC field.

2. Join the tables
 

a. In ArcMap, close the open attribute table.
b. Right click on the table of contents for the Hadley landuse entry. 
c. Choose “joins and relates.” Choose join. Fill in the prompts with: LU21_CODE, 

LUSPC, and IT_VALI When complete, your relate window should look like this:
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d. Press OK.
e. Open the “lus117p1” layer attribute table. Scroll over to “IT_VALIDESC”. This is 

the field with the legend codes. 

3. Set up legend based on a field in the attribute table.

Now we can change the symbology associated with the layer to use the new text 
associated with landuse categories so that these codes are shown in the TOC legend – 
NOTE this is an important technique to remember -- you could do this for any layer to 
change the TOC legend based on a value in the attribute table.

a. Right click on the layer in the TOC and choose properties.
b. Choose the symbology tab.
c. Choose categories > Unique values (we’ll develop a legend for this layer 

based on the unique values in the IT_VALIDESC field).
d. Value field: luspc.IT_VALIDESC
e. Press the “Add all values” button
f. Choose a color scheme you like (or choose one and then double click on 

individual colors to change them, such as green for forest)
g. Click off “all other values”
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h. Apply
i. OK

j. You should see the new legend appear and the map of the layer with 
colors associated to various landuse categories!
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ArcGIS v10 Model Builder Exercise

 “Commercial Areas of Interest in Hadley, MA”

 
2011 Maria Fernandez, Charlie Schweik, Lara Aniskoff

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this license, visit 

http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic Information (MassGIS), 
Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). Any further use of 

these datasets in other situations should acknowledge this organization.

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

Model Buider

The model builder is a modeling environment available in all ArcGIS products. For many, it is a 
more intuitive way of doing geoprocessing than using programming scripts (e.g., Python) or 
commands. In the language of ArcGIS help, “it is a powerful and efficient tool which can 
streamline workflows.” 

One of the real benefits of using the Model Builder function of ArcGIS is self-documentation. 
The models can be saved and run again, whereas if you simply use a series of manual operations, 
it may be difficult to recreate the process exactly. Models can also be placed within geodatabases 
or saved as files for distribution. You could bundle a number of data sources along with a model 
to allow a collaborator to validate your methods.”

The best way to learn Model Builder, is to “play” with it. This exercise is intended to 
show you just a little of how to find your way in this environment. You are encouraged to 
try this same model with another data/geographical location, modify the model to do 
something else, or even construct your own model from scratch. 

This exercise

Imagine that you work for a company that is trying to set up a retail location for their products in 
the Hadley, Massachusetts area (note this same question could be asked by land conservation 
organizations trying to protect threatened land). Suppose, in either case, the organization 
interested ask you to produce a map of the Hadley MA area that has retail development potential. 
To start, you decide that areas of interest should:

- be flat (less than 3 degrees slope); 
- be close to roads (less than 150 m from any road); and 
- fall in zones allocated to business/industrial areas in the town of Hadley.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Data

Download and unzip the data from the course website to your c:\temp\gisdata folder. 

Open the project “Modelbuider.mxd”. Look in the table of contents: there are three data sets: 
“EOTROADS_Arc_117” , “zn117p1”, and “hadleyDEM”. This is where the data comes from:

“EOTROADS_Arc_117”: http://www.mass.gov/mgis/eotroads.htm (you are already familiar 
with Mass GIS roads layer tiled by town).

“zn117p1”: http://www.mass.gov/mgis/zn.htm (this is the “zoning” layer for the town of Hadley)
Here you have some relevant documentation about this data obtained from the Mass GIS site:

“The MassGIS zoning datalayer represents the boundaries of municipal zoning districts. 
Because zoning is established at the town level, there is no standard district classification 
across the state. While districts in different towns may have similar or even identical 
names, their definitions are often quite different. Generalized codes have been added to 
make these data useful for regional display. A related table contains detailed information 
about the districts such as setbacks or text descriptions from each town’s zoning bylaws”. 

This is an important issue that we should consider for the proposed problem: if this were 
“real life”, we should obtain the most updated zoning map directly form the town (but for 
the purpose of this exercise, we will go ahead and use this layer):

“Zoning district boundaries change frequently and MassGIS currently has no formal 
process in place to regularly update these coverages.  These data should therefore be used 
for regional analysis only and not as official zoning maps.  The town’s own official 
zoning map and current copy of the by-law should be considered as the final word on 
zoning boundary questions or issues”. 

“HadleyDEM”: http://seamless.usgs.gov/

In this website, we zoomed to the Hadley area and obtained a 30 m DEM in geographical 
coordinates NAD 83. We reprojected to Mass State Plane NAD 83, and “clipped” it using the 
boundary of Hadley as a mask. (If you ever need to perform this operation, here you will find 
detailed instructions. We will also do an exercise in clipping in a future exercise): 

How to clip a multiband image using ArcGIS and Spatial Analyst:
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=22526

Below shows the 30 meter digital elevation model (DEM) clipped out for the Hadley area. This 
is being displayed as a gray “hillshade” area and is draped on top of the broader DEM that we 
downloaded from the USGS Seamless website (http://seamless.usgs.gov/). . 

http://www.mass.gov/mgis/eotroads.htm
http://www.mass.gov/mgis/zn.htm
http://seamless.usgs.gov/
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=22526
http://seamless.usgs.gov/
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With that accomplished the layers that we will use in this exercise are:

Digital Elevation (raster) and
Roads (line vector)
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A zoning layer for the town of Hadley, MA

Overview of the process
The logic that we will follow:

1) We will intersect a layer of the flat zones (slope < 3 degrees) with the polygons that 
represent commercial/industrial areas in the town of Hadley. 

2) We will then clip the intersection result with the 150 m buffered roads. The result of 
this process will be a layer that represents FLAT, COMMERCIAL, CLOSE TO ROADS 
LOCATIONS IN HADLEY. 

The idea is pretty simple but there are lots of steps in the process. This is how the logic of the 
final model looks for you to have a general idea of what we are about to do:

1) Take the DEM and create a slope_hadey1 grid
2) Reclassify the slope_hadley1 values such that cells < 3 degrees are set as a “1” and cells 

> than 3 degrees are set to 0. 
3) Extract the cells that are set to 1 (<3 degrees)
4) Convert the raster grid to polygon. So we create a slope polygon map of all the locations 

in Hadley that fall under <3 degrees slope. 
5) Select the polygons in Hadley that are zoned “commercial”
6) Intersect the slope under 3 degree polygon with the commercial polygons to produce a 

“commercial_flat.shp” layer. 
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7) Create a 150 meter roads buffer polygon 
8) Clip the commercial_flat shape file using the 150 m road buffer layer to produce an 

output polygon layer called “area_interest.shp”

This is the power of GIS in general, and the ModelBuilder in general. The model builder 
helps to do all these processes in one “model run” and you can return and run it again, or 
change the logic, in the future. The full model we’ll produce looks like this:

1. Obtaining a polygon map with “flat areas”

Step 1. Create a model in toolbox:
Open Arc Toolbox, right click and go to “add toolbox”.  From the “Add Toolbox” window click 
on the “New Toolbox” icon on the top right.  

Name it “Hadley_Model.tbx”. Click on your new model and click “Open” to add it to 
ArcToolbox.  The Hadley_Model toolbox will now be added to the ArcToolbox menu.  

Now right click on the Hadley_model and choose > New > Model.
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An empty window called “Model” appears. This is the environment where we will build the 
model. Remember to save your model as you go along, it will not be saved automatically when 
you save your ArcGIS project.  

Step 2. Import data into the model:

We will import the DEM into the model, and add analytical operators in a “work flow” to obtain 
the areas under 3 degrees of slope. Drag the “hadleydem” from the table of contents. (You could 
also drag it from ArcCatalog or use the “Add data” button). 

As you can see, data is represented with a blue oval in Model Builder.
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Step 3: Add tools from ArcToolbox .

Go to the ArcToolbox tree, and navigate to “Spatial Analysis tools>Surface”, grab the tool 
“Slope” and drop it inside the model:

The slope tool comes up connected to an “output data set”. 

Step 4. Adding connections:

Now, in the Model Builder window, grab the “connection” button  in the model toolbar and 
connect “hadleyDEM” with “slope”. Click on hadleydem then Slope to connect, then click 
“Input Raster.”

The tool and the output get “activated”. In model builder, tools are represented with yellow 
rectangles, and “outputs” or “intermediate data sets” with green ovals. 
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Step 5. Adjust/enter parameters:
Again, in the Model Builder window, grab the selection button  and double click in the 
“slope” tool to see the parameters. Save to your temp folder on the C drive and name 
Slope_hadley1. 

This Slope tool uses the elevation data to create a new raster (grid) where the values in the cells 
represent the slope in degrees (e.g., 0-90 degrees). This is good example of how GIS provides a 
mechanism to convert one layer representing some data to another new layer representing some 
mathematical operation on the first layer’s data.

Click OK.

You can rename the output (the green oval) in the model by right clicking the “output raster” 
oval, choosing rename, and rename it to “Slope_hadley1”.

Step 6: Continue adding more tools/processes to the model:

Now we will reclassify the raster dragging into the model the reclassifying tool:
(ArcToolbox, Spatial Analysis tools> Reclass> Reclassify). Connect the tool to Slope_hadley1.
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Set the values for the reclassify parameter: Double click in “reclassify” tool, and a window with 
parameters will appear.  Follow the screen shot below. Make sure you separate numbers and the 
“-“ with blanks on the “old values” side.

This function creates a new raster or grid layer where the cells have values of “1” if they are very 
flat (between 0 and 3 degrees slope) and “0” if they are steeper than 3 degrees slope. 

Rename the output oval to “SlopeReclass.” 

Step 7.  A useful side note: Creating a variable for the “reclassification table”.
We could create a variable that represents the reclass table that we just created. This will be a 
light blue oval: a “Value parameter” that references non geographical data. 

Right click in “Reclassify”, and go to “Make Variable > From Parameter > Reclassification”. 

 Double click in the variable blue oval, you could save the current table as “reclass3”, but also 
modify it and save it with another name. You can also “load” any reclass table that you may have 
created. 

This allows us to run a model several times with different parameters in no time!
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Step 8. Reorganize the model appearance

At any time you can use the buttons of the model window toolbar: 

 will reorganize the appearance of the model. 

 will fit all the model in the window

 will help you “find your way” in the model layout.

Your model should look like this so far:

Step 9. Extract out the “slope under 3 degrees ” cells.

We will go a little faster from now on, as you know the basics of constructing a model. Drag the 
tool”Spatial Analysis Tools>Extraction>Extract by attributes”. Connect to “Reclass_Slope.” 

 Double click in “Extract by Attributes” tool and modify the “where clause” to extract the 
“values = 1”, as we know those are the raster cells where slope is under 3 degrees. Rename the 
output to Slope_under3.
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Now drag the tool “Arc Toolbox>Conversion Tools>From Raster>Raster to Polygon”. Connect 

the tool to “Slope_under3”.   Double click and adjust the parameters, rename the output 
“slope_under3.shp”

We created the slope polygon map! We will intersect this dataset with the zoning dataset, but 
first we should select the zoning areas for commercial/industrial purposes.

2. Select commercial/industrial areas in the town of Hadley

Step 1. Drag the shapefile “zn117p1.shp” from the Table of Contents into the model. 
Step 2. Add the tool “select” (Analysis Tools>Extract>Select). 

Step 3. Connect those two.  Double click in “select” and set up the parameters: 
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This is the expression that you should type in the query builder to select business and industrial 
zones:

"ZONECODE" = '117B' OR "ZONECODE" = '117I' OR "ZONECODE" = '117LB'

 (a look at the metadata for the layer, the attribute table and other additional .dbf tables that came 
with the data would take you to the same conclusion).

Rename the output “Commercial.shp”

3. Intersect “Slope_under3.shp” and “Commercial.shp”

Step 1. Add the tool “Intersect” (Analysis Tools>Overlay>Intersect). 
Step 2. Connect the tool to the two shapefiles we want to intersect.

Step 3. Reorganize the appearance of the model.

Step 4.  Double click in the tool and set parameters: Select the two shapefiles as input 
features, call the output “commercial_flat.shp” and go ahead with the other defaults.
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4. Create Road Buffers and clip “commercial_flat.shp”.

Step1. Drag “EOTROADS_ARC_117” layer from table of contents.
Step 2. Drag “buffer” tool into the model (Analysis tools > Proximity > Buffer)

Step 3. Connect both.  Double click buffer and set parameters.
Call the output: Roads_150buffer.shp, define a buffer of 150m and select “Dissolve Type”: ALL
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Step 4. Drag the tool “Clip” (Analysis tools > Extract > Clip). 
Step 5. Connect it to Roads_150buffer.shp and Commercial_flat.shp

Step 6.  Reorganize the appearance of the model.

Step 7.  Double click in the “clip” tool and set parameters.
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Set commercial_flat.shp as input, roads_150buffer.shp as clip features, and name the 
output “area_interes.shp”.

5. Set Model Parameters

You can set up some of the parameters as Model’s Parameters. The user will have to 
define those parameters when running the model from the ArcToolbox window. If you 
want to see how this works, you can right click the “Reclassification” input (light blue 
oval), and check “Model parameter”.

6. Save the model

Note: You can also go to Model > Validate Entire Model from the Model Builder 
window to make it so that the files can be overwritten.  One way to proceed is to run your 
model as you add steps to make sure that it is working, then validate and do a final run 
when it is completed.  After running a model all the actions and inputs get a grey shadow 
indicating that they have been run.  Validating removes this so you can see that nothing 
has been run and there are no attributed files.  
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8. Run the model

We are almost done!

 Reorganize the appearance of the model. Go to Model > Run, or click the button: 

Relax, sit back and observe the model running. 

As the model is running the process that is currently being completed will be highlighted 
in red, and a dialog box will open showing the results of the run.  

If all the parameters are correct, the model should run to completion and you will see that 
the model parameters now have a grey shadow. Otherwise, it will stop where there are 
errors, and you will have a chance to fix any problem. This always takes a little bit of 
“debugging”. You can run the model all at once, or run any tool you want (Right click the 
tool> Run), and then the model will run only to produce any inputs that the tool requires. 
Many of the “green ovals” are intermediate data sets, but if some of them are of interest, 
you could right click them and select “Add to display”, so you could examine the 
intermediate outputs. 
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If you didn’t have time to get here, open the tool “Hadley_model” in the Arc Toolbox 
tree: there is a model ready to go so you can explore it. Right click Model > Edit, and run 
the model from the window tool.

9. Display results

Add “Area_interest.shp” to the table of contents and look at the results. Yellow (Clear) 
polygons represent the “flat-commercial-close to roads” areas that we were looking for.
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Analysis: “Select by location” Queries 
(Neighborhood analysis)

 
2011 Charlie Schweik, A. Stepanov, R. Taupier, M. Fernandez

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

Datasets used for this exercise were generously provided by the Office of Geographic Information 
(MassGIS), Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). 
Any further use of these datasets in other situations should acknowledge this organization

Introduction

In this exercise we will use the basic “selection tool” called “Select by Attribute” (we’ll look at this more in 
the database exercises too). But we’re also going to use the “Selection by Location” query function, which 
allows us to do what some refer to as “neighborhood analysis” – locational queries based one or more 
layers.

Before we start, let’s consider the types of locational questions we might be able to answer. 
Suppose you had a point, line or polygon layer, and you wanted to ask locational questions as it relates to 
another point, line or polygon layer. What general types of questions might we want to ask? See for 
example, the point-to-point cell below. What questions might we ask in the other cells?

http://creativecommons.org/licenses/by-nc-sa/3.0/
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TARGET (ACTIVE) LAYER

Are points within 
distance of points?

Do points completely 
contain points?

Do points intersect 
points?

Are points in one layer 
within a distance of 
polygons in another 
layer? 

Are points completely 
contained within 
polygons in another 
layer?

Are lines in one layer 
within a certain distance 
of lines in another line 
layer? 

Do lines in one layer 
intersect with lines in 
another layer? 

Se

HANDS ON EXERCISE USING THESE CONCEPTS

1. Download and unzip the dataset for today’s class to C:\temp\gisdata. 
[Note: These are older ArcInfo coverages.  They still are around on the Internet, so we are trying to give 
you some experience working with them.]

2. Open up a new ArcMap document. Invoke the ArcGIS Desktop help. Go to the SEARCH tab. Search for 
“Select by Location.” Locate the “Using Select by Location” entry.  Check out the different descriptions for 
these functions, where the help subheading says “Types of Supported Spatial Queries.” Notice the list of 
functions this option provides – they generally coincide with the “dual-map” analysis matrix provided 
above. Close the help window.

3. Open ArcMap. Add the following layers:

Towns towns boundary polygon layer
Swaste solid waste sites polygon layer

Point                    Line                        Polygon
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BASINS major watersheds polygon layer within MA
Rivers major streams arc (line) layer

4. Change the symbology for the BASINS (watersheds) layer such that there is no fill 
color and the outline is in red. Change the symbology for the TOWNS layer such that 
there is no fill color. [How do you get to symbology for a layer? Do you remember?]

5. Use ArcMap “selection” functions to answer these questions. Remember there are 
three ways you can do selection queries: 

 TOC selection menu by right clicking on TOC entry – e.g., “Select All”
 From the toolbar use the “Selection” menu, Select by Attribute function
 From the toolbar use the “Selection” menu, Select by Location
 Note also under the selection menu the “statistics” option that provides 

information about selected features. 

Below we have a set of questions we want you to try and figure out. Write down the 
procedure you undertook in the space provided. After you are done, we’ll review the 
techniques to do this (the answer key at the end of this exercise).
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1. How many solid waste sites exist in the swaste layer?  [try and figure this out 
before you look at the answers on the next page]. 

628 (Two ways – (1) Open up attribute table, look at how many records; or (2) 
Right click on the swaste entry in Table of contents, Selection menu, choose 
“select all.” Then go to selection menu, STATISTICS to see the count value.

2. How many solid waste sites are located within the Connecticut River 
watershed? Discussion - What are the conceptual steps needed to get this 
answer?

Implement your conceptual steps. How many such sites did you find? 
Make sure you CLEAR SELECTED FEATURES before starting the next 
exercise.

3. How many waste sites in Massachusetts are closer than 0.5 miles to 
streams/rivers? Make sure you CLEAR ALL before starting the next question.

4. How many towns are there in Massachusetts?

5. How many towns are completely contained within Connecticut River 
watershed? Clear all before going on to #6.
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6. What towns have a boundary adjacent to the town of Marlborough?
(Note: there is a trick to getting this answer). Clear all.

7. What towns completely within the CT River Watershed had a 1990 
population greater than 25,000 people?  Create a new layer called “CT River 
towns” to help answer this question.  (Hint: create new layer is an option on 
the right-click menu in the TOC).
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Answers to Neighborhood Analysis Questions

(DO NOT LOOK AT THESE WHEN DOING THE PREVIOUS EXERCISE! 
CHECK THESE ONLY WHEN DONE OR STUCK!) :

1. 628 (Two ways – (1) Open up attribute table, look at how many records; or (2) 
Right click on the swaste entry in Table of contents, Selection menu, choose 
“select all.” Then go to selection menu, STATISTICS to see the count value.

2. How many solid waste sites are located within the Connecticut River 
watershed?

Conceptual steps:

a. Select the CT River watershed boundary
b. Select the waste sites that fall within the CT river watershed
c. Now get a count of the number of polygons selected using selection 
statistics

Detailed steps:

a. Select the CT River watershed boundary
i. Click on the basins layer in TOC to get it active

ii. Selection menu, Select by attributes
iii. Layer: basin polygon
iv. “Name = “
v. Get Unique Values

vi. Choose “Connecticut”
vii. Should say “”NAME” = “CONNECTICUT in Select * window

viii. Apply, Close
ix. The CT River Watershed should be highlighted (selected)

b. Select the waste sites that fall within the CT river watershed
i. Selection menu, Select by location

ii. “Select features from” 
iii. Target layer(s): “swaste” polygon
iv. Source layer: Basins polygon (should have 2 selected)
v. Spatial selection method: “Target layers features are within the 

Source layer features”
vi. Apply, OK

vii. You should see all the solid waste sites selected within the CT 
river watershed.

c. Now get a count of the number of polygons selected
i. First need to deselect the CT River basin polygons for we don’t 

want that in the count. 
ii. Click on the “BASINS polygon” in the Table of Contents

iii. Right click, Selection, Clear selected features. 
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iv. You should see that watershed boundary become unhighlighted 
(unselected). But the selected swaste sites should remain selected.

v. Right click on the swaste layer
vi. Selection, open table showing selected features.

vii. At the bottom it says “40 out of 628 selected.”
viii. ANSWER: 40.

ix. Clear the selected waste sites (right click on swaste table of 
contents entry, selection, clear selected features).

3. How many waste sites in Massachusetts are closer than 0.5 miles to 
streams/rivers?

a. Selection menu, select by location
b. Select features from “swaste polygon”
c. Source layer: “rivers arc”
d. Target layer(s) features are within a distance of the source layer feature” 
e. Check on the “Apply a search distance”  Type in “.5” and select “miles”
f. Apply (this might take a little while), OK 
g. Right click on the swaste layer in the TOC
h. Open attribute table
i. Look at bottom of window. Should see “268 out of 628 selected”
j. Answer: 268
k. Close Attribute table, Selection Menu, “Clear Selected Features”

4. How many towns are in Massachusetts?

a. Did you open the attribute table and say 631? That’s an error, since some 
towns in Massachusetts have more than one polygon.

This was in some ways an unfair question because you haven’t seen some 
of the ways to do this. But perhaps you figured it out! 
 

b. One way to get the right answer:

i. Open attribute table of towns
ii. Look at for example Newburyport – multiple polygons

iii. Right click on column heading “Town-Name” 
iv. Choose “Summarize” option  – “creates a summary table creating a 

unique value of the selected field, along with statistics…” Leave 
default settings. This creates a new output table with summary 
information. 

v. Choose OK
vi. “Do you want to add the result table to the map?” YES

vii. A new database table, Sum_Output will be in the Table of 
Contents. 

viii. Right click. Open 
ix. Answer – 352 rows. That’s how many towns.
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5. Number of towns in the CT River basin

a. Same process as in #2 – just a little more practice.
b. Answer: 13

6. Select all towns that are adjacent to the town of Marlborough.

a. The challenge of this query is that select by location requires two different 
layers. It won’t work with the same one twice.

b. So, to get this to work, you need to add a second town layer. 
c. Properties, rename the second one to “Towns polygon 2”
d. Get the first town layer active. Select by attribute. Select where “town = 

‘Marlborough’” (use Get Unique Values to get the list of towns if you 
don’t want to type it in by hand) 

e. You should see the town of Marlborough selected on the map. 
f. You could at this point do a manual method and use the identify tool (the 

little “I” icon” and click on the town boundaries adjacent to this selected 
one. But let’s use the database and Select by Location to answer this 
question. 

g. Now issue Selection menu, Select by location. Select features from the 
other town polygon layer (there will be two to choose from and they are 
ordered by their order in the TOC. Choose the one you haven’t used 
earlier. This should be Towns Polygon 2”)

h. Source layer: Towns polygon. 
i. Use selected features. Should say “1”.
j. Turn the search distance off if it is on from earlier. 
k. Apply, OK. 
l. You should see the towns adjacent to Marlborough show up as selected.
m. To figure out which ones are selected, you can right click on the towns 

polygon 2 layer, Selection, “Open Table Showing Selected Features.”
n. The answer should be: Sudbury, Berlin, Hudson, Northborough, 

Framingham, Southborough.

7. What towns completely within the CT River Watershed had a 1990 
population greater than 25,000 people?  

a. Select the CT River watershed boundary
i. Click on the basins layer in TOC to get it active

ii. Selection menu, Select by attributes
iii. Layer: basin polygon
iv. “Name = Connecticut”
v. Apply, Close

vi. The CT River Watershed should be highlighted (selected)
b. Select by location. “Select feature from” “towns polygon” target layer
c. Source layer: Basins polygon
d. Use selected features 
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e. Spatial Selection Method: “Target layer(s) features are completely within 
the Source layer the source layer feature” 

f. To create the new layer: Right click on the towns layer that has these 
selected towns. Choose selection, “Create Layer from Selected Features.”

g. Select by attribute. Pop90 > 25000. Open attribute table. Selected records. 
Amherst and Northhampton.

Note: creating a new layer in this way does NOT create a new geodatabase layer 
or shape file or geodatabase feature class. It simply creates a new listing in the 
ArcMap document that recalls this query and the format you set up. So a layer in 
this context is stored in the ArcMap document (.mxd). 
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ArcMap’s Geoprocessing/ArcToolbox:
Dissolving, Buffering, Clipping, Merging, and Vector Overlay

 
2011 Charlie Schweik and Maria Fernandez

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic Information 
(MassGIS), Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). 

Any further use of these datasets in other situations should acknowledge this organization.

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

Introduction: 

This exercise provides the student with some experience using some of the “Vector 
Overlay” and transformation functions found in ArcGIS tools. Functions we review in 
this exercise include:

Dissolve – This function aggregates (combines) features that have the same value in a 
field in the attribute table. It is helpful if you want to simplify the number of features in a 
layer to the unique ones you have.  

Buffering – Rings drawn around features at a specified 

Clipping – “Cookie cutting” of one layer using another layer

Merging – Combine several adjacent layers into one layer

To begin, Download the “analysis2” data from the course website to your work folder 
(e.g, c:\temp\gisdata).

Exercise 1 - Dissolve, buffering, clipping

Suppose you are working for the planning agency of the town of Lynn, Massachusetts. 
There are few wetlands on the town's territory are in dire need of protection. You need to 
change the requirements of how close you can develop to a designated wetland. 

Currently there are restrictions of 100 feet buffers around wetlands. You are considering 
extending that to 220 feet (120 more feet). Before you make a decision, you want to 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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know what land uses will be affected by the new bylaw. You have a GIS theme on 
landcover/landuse in the area. 

Your task: 
a. Create a 100-foot buffer around identified wetlands in Lynn 
b. Identify what types of land uses are within 120 feet from the buffer zones.

STEP1: DISSOLVE

1. Start ArcMap.
2. Add the shapefile polygon layer containing data for land use for the town of Lynn 

- lus163p1.shp (this is from MassGIS)
3. Make Land Use the active theme, right click and open the attribute table. As you 

can see there are 298 features in this layer. 
4. Scroll to the right and look at the “Descriptio” (description) field. Recall that land 

use is classified into 21 categories. By using Dissolve, you can reduce the number 
of features from 298 to 21. With fewer features to process, subsequent 
geoprocessing tasks will take less time and will be less confusing.

5. Close the table. 

Click the icon to show ArcToolbox application. Navigate to Data Management Tools-
Generalization-Dissolve:

 

Dissolve
Tool

Dissolve 
Wizard

ArcToolbox 
Show/Hide icon
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The ArcToolbox suite of tools has some *really* useful functions, similar to some of the 
“Select by location” queries we were doing in another analysis exercise.  The difference 
is that these functions create a new layer – the “Select by location” under the selection 
tool just makes certain layer features active or “selected”.

It is in ArcToolbox that you can perform the VECTOR OVERLAY functions. Some of 
the tools organized in ArcToolbox allow you to merge themes together into one, clip out 
one theme based on the geographic extent of another theme, intersect or union of two 
themes, among lots of other useful operations you may need to perform with your vector 
data. But here we'll use dissolve.

1. For the input features, scroll or browse to select the data set you want to dissolve: 
lus163p1.shp

2. For the “Output feature class” navigate to your work folder (e.g., c:\temp\gisdata), 
but change the file name: 21_landuse.shp

3. For the attribute to dissolve, choose “DESCRIPTIO” in the dropdown list.

4. SCROLL DOWN… In the “Statistics Field” click AREA, and under “Statistic 
type” click SUM. Do the same for PERIMETER. (This will create these two 
columns in the output attribute table with these sums.) 

Click OK. You’ll see it “dissolving…” and eventually 21_landuse.shp will appear 
in the table of contents.
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5. Make 21_landuse.shp the active layer in the TOC, and right click Open Attribute 
Table. Notice that the Attributes of 21_landuse.shp table now contains only 21 
records.

All polygons belonging to the same Descriptio class now share a single record 
in the attribute table. Furthermore, we know how many polygons are 
represented by each class (Count_DESCRIPTIO), and the total area (Sum_Area) 
and total perimeter (Sum_Perimeter) of all the polygons of each class.

How much area (in meters) in Lynn are wetlands according to this landuse 
layer?

62,349

6. Close the layer attribute table.

STEP 2: CHANGE THE LEGEND SO YOU CAN REALLY SEE THE 
WETLANDS.

QUESTION: Do you recall how to create a legend in the TOC based on the 
DESCRIPTIO field values? What we’d like is a map that displays all wetlands in 
bright green so we can easily see them.  
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7. The theme 21_landuse is symbolized with a single symbol. 

8. Double-click on the theme to open the layer properties. Click on the Symbology 
tab. It will be defaulting to “Features, single symbol”

9. Double click on Categories. Choose Unique Value. In the Value Field choose 
Description. Notice it has a blue color for “all other values”. Change that to red.

10. Select “Add all values” and choose wetlands. Change the wetlands color to 
something really distinctive (e.g., Black works pretty well, depending on the color 
scheme you picked.) 

11. Click OK. You should be able to clearly see 6 wetland polygons on the map.

STEP 3: BUFFERING THE WETLANDS

12. Next, we will create the existing 100-foot buffer for wetlands -- see for example 
the EPA's Water Quality Standards for Wetlands 
(http://www.epa.gov/OWOW/wetlands/regs/quality.html)

13. To buffer only wetlands, we must first select them. You should know how to do 
this from previous exercises… 

With 21_landuse.shp active in the TOC, invoke “Select by Attribute” 
under the Selection menu. 

The query should be “DESCRIPTIO” = “Wetland” (if wetland is not in 
the list, press the “Complete list” button.

Click Apply and close. The wetland polygons should be selected.

14. From the ArcToolbox list, select Analysis Tools, Proximity, Buffer wizard. 
15. In the “input features” dropdown list, choose 21_landuse.shp as the theme to 

buffer. The process will be carried out only on the selected features of 
21_landuse.shp, i.e. wetlands.

16. For the output, navigate to your project folder (e.g., c:/temp/gisdata) and specify 
the name of the output feature class as”21_landuse_buffwetlands”. 

17. Under “Linear Unit”, specify the distance of 100. Choose Feet as the Distance 
units in the dropdown list.

18. Choose ‘All’ in “Dissolve type” to dissolve barriers between buffers. Click OK
19. With this operation, you obtain polygons that include the original polygons plus 

the “buffer” areas. If you were interested only in the “buffer” areas, you would 
have to perform an additional operation clipping the “buffer” result with the 
original polygons.

http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
http://www.epa.gov/OWOW/wetlands/regs/quality.html
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20. Clear the selected features (Selection, clear selected features)
21. Make the new buffer theme active and right-click and Zoom to layer. Now you 

can see the area of interest. Change the fill color for the buffer so that it is 
transparent (turn the color off by double-clicking in the box in the TOC and 
choosing no fill color). 

Your map should look something like this:
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STEP 4: FIND OUT WHAT LAND USES ARE WITHIN 120 FEET DISTANCE 
FROM BUFFERED WETLAND ZONE. 

QUESTION TO ANSWER: What land categories are within 120 feet from a 
buffered wetland zone?

You’ve already learned how to do this from the previous lab exercise. How would 
you do this?

See if you can figure it out… if you give up, see the next page.
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Use the “Select by Location” function under the Selection menu. 

1. Selection menu, Select by location. 
2. Select features from: 21_Landuse 
3. Source layer – 21_Landuse_buffwetlands
4. Spatial selection method: Target layer(s) features are within a distance of (3d) of 

the Source layer feature
5. Apply a search distance of: 120 feet.
6. Apply, Close
7. Open the 21_landuse.shp theme attribute table. Display only the selected records. 

The land categories affected by this proposed bylaw are: Forest, Residential 1, 
Residential 3, water and other wetlands.

Now you know what categories of land use will be affected by the new bylaw.

STEP 5: CLIPPING LAYERS

Zoom to the full extent of the map. It is still hard to tell from the selected features in 
the map what is being affected by this proposal. 

To perform a more accurate analysis of what patches of land will be affected, you can 
perform buffering for wetlands and then use the buffer layer to "clip" or “cookie 
cut” the original land use theme. In this case you will have to choose buffering 
distance of 220 feet (the new proposed total).
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What would the conceptual steps be to do this?

General steps:

1) Select the wetlands from the original land use layer (the non-dissolved one – 
lus163p1.shp)

2) Create a 220 feet buffer area around these selected wetlands.
3) Clip or cookie cut the lus163p1.shp layer with the buffer layer to produce a map 

with just the land uses falling within the buffer areas.

Details:

1. Clear selected all features
2. Selection menu, “Select by Attribute” 
3. Choose the lus163p1 layer
4. In the Fields list, double-click on [Descriptio]. Click the equals sign button (=). 

Click “Get Unique Values.” Double-click on “Wetland.” Apply > Close. The 
wetlands should be selected.

5. Tools menu, buffer wizard. 
6. Choose lus163p1.shp as the theme to buffer. Check use selected features. Click 

Next
7. From the ArcToolbox list, select Analysis Tools, Proximity, Buffer wizard.
8. Complete the wizard as in STEP 3, and specify a distance of 220 Feet 
9. Dissolve all, to dissolve barriers between buffers. 
10. Click OK.

11. Now we will use the Clip function. 
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Like a cookie cutter, clipping a layer overlays a polygon layer on another 
layer (called the input layer). The resulting output layer contains features 
from the input theme that fall within the clip theme's boundaries. 

12. Because you no longer need the selected set of wetlands, you'll clear the selected 
features in Lus163p1.shp. Make Lus163p1.shp active, right click, selection, Clear 
Selected Features.

13. ArcToolbox > Analysis Tools > Extract > Clip: 

14. Use as “input features” Lus163p1.shp.
15. For the “clip features” choose your new buffer layer.
16. Write your output to your project folder (e.g., c:\temp\gisdata), but remember 

what the name is. Click OK.

17. Turn on your new clipped layer (it might be called “Clip_Output”) in the TOC. 
Turn off all the other layers. 

Clip 

Clip Wizard
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18. Right click in TOC and Zoom to layer if you need to.
19. Change the legend so it displays unique colors for different descriptions. You 

should remember how to do this now…
- Double-click on the layer name in the TOC
- Choose the symbology tab 
- Choose categories, and Unique Color
- Add all values
- Turn off “all other values”

20. Now you can label these polygons by going into the layer Properties, labels 
option. Choose “description”. 

You now have a map showing the various land use parcels affected by the new 
proposal.

Finally, notice that the new layers we created are shape files. (If you go to explorer or 
Arccatalog you will see this.)
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Exercise 2. Merging and Clipping themes

Let's do two other common tasks:

a) Wanting to combine (merge) separate vector layers into one big layer, and 
b) Wanting to clip out an area in one theme based on the geographic 

boundaries of another layer.

Often merging is needed because there are multiple vector layers that side-by-side cover 
the area of study. 

Suppose while working on the changing the requirements of how close you can develop 
to a designated wetland, you have received the orthophoto wetlands datalayers. (These 
are another set of MassGIS layers -- see http://www.state.ma.us/mgis/w.htm). They are 
registered to, and tiled by, the orthophoto quad library. 

In our data files that we downloaded and unzipped earlier, we have five wetland tiles for 
the city of Lynn: 

w3172p1.shp
w3173p1.shp
w3253p1.shp
w3254p1.shp
w3255p1.shp

Plus we have the town boundary file for Lynn: lynn.shp

You will merge them in one theme and cut them using town boundary theme as a cookie 
cutter.

1. First, none of the wetland shape files have their projection information assigned to 
them. In ArcCatalog, assign each one to NAD83, State Plane, Mass Mainland, 
meters.   

2. Open a new ArcMap document. (no need to save the old one.) 

3. Add the datalayers containing five orthophoto wetlands (the polygon shape files) 
and Lynn town boundary. 

Zoom to the full extent and display the Lynn layer first in the TOC. Notice that 
there are several wetlands layers that fall within the Lynn geographic boundary.

Let’s merge the wetlands layers together into one layer.

http://www.state.ma.us/mgis/w.htm
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4. ArcToolbox > Data Management Tools > General > Append: 

5. Append attaches other layers (in this case shapefiles) to one “target” layer or 
shapefile. In this case, choose the first four wetland layers as Input Features.

 w3172p1.shp
w3173p1.shp
w3253p1.shp
w3254p1.shp

6. Set the “Target Dataset” to the last, unused wetland layer: w3255p1.shp.

7. Click OK. Turn off all other layers but w3255p1.shp. You should see all of the 
wetlands that are now appended to it. 

8. Now let's clip out just the wetlands that fall within the border of the town 
Lynn.

9. ArcToolbox-Analysis Tools-Extract-Clip 

10. Choose your merge layer as your input layer. For the overlay layer choose 
Lynn.shp from the dropdown list.

11. Go with default file names. Click OK.

12. Click off everything from the TOC except the Lynn layer and your new clipped 
wetlands layer.  

Append 
(merge)

Click here to 
add several 
data layers

Append wizard
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13. Now you have a new datalayer containing the wetlands data for the city of Lynn. 
You’ll see that there are still the borders of the various “tiles” in this new 
appended layer. That is more problematic potentially for other analyses, but for 
viewing changing the symbology color and turning polygon outlines off will 
remove that visual problem.  
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Quick Vector “Field Calculator” Exercise

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons 
Attribution-NonCommercial-ShareAlike 3.0 Unported License. 

To view a copy of this license, visit 
http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office 
of Geographic Information (MassGIS), Commonwealth of 

Massachusetts, Information Technology Division 
(www.mass.gov/mgis). Any further use of these datasets in other 

situations should acknowledge this organization

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

Download and unzip the solidwaste coverage and store it in c:\temp\gisdata.

Often in some kind of analysis process you want to calculate some new attribute 
based on the values of one or multiple other attributes.

Example: Suppose we want to figure out how many acres each polygon represent in the 
Solid Waste layer we used in a previous class? 

To do this, the general steps are:

1. Add a new field to the layer attribute table
2. Edit the layer 
3. Use the Calculate Values option to do math on the new field. 

Specific steps:

1. Open ArcMap
2. Add the “swaste_polygon” shapefile
3. Open attribute table 

a. Note that there already is an Acre field (so we know the answer). Let’s 
calculate that number using the Area data for each record (polygon).

b. The math for this calculation is Acre = Area / 4047 (there are 4047 sq 
meters in an Acre)

4. Add a new field called “ACRECALC”, set the Type of field to “Long Integer”
5. Calculate the new Acrecalc field using the field calculator

a. Open attribute table
b. Here’s the key step: Right click on the field name “acrecalc”. Choose 

“Field Calculator”

http://creativecommons.org/licenses/by-nc-sa/3.0/
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i. Choose [AREA]/4047

ii. Hit OK
iii. You should see the rounded acreage in the Acrecalc field. 

Compare it to the ACRE field.



126

Raster-based Analysis:
Using the Spatial Analyst Extension and Digital Elevation Models (DEM)

2011 Charlie Schweik, Lara Aniskoff
Note: This work is licensed under the Creative Commons 

Attribution-NonCommercial-ShareAlike 3.0 Unported License. 
To view a copy of this license, visit 

http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the 
Office of Geographic Information (MassGIS), Commonwealth of 

Massachusetts, Information Technology Division 
(www.mass.gov/mgis). Any further use of these datasets in other 

situations should acknowledge this organization.

Note: Data for all exercises are available at:
http://courses.umass.edu/nrc592g-cschweik/data.html

Exercise objective: To develop several new grid themes related to elevation, specifically a 
SLOPE theme, an ASPECT theme, a HILLSHADE theme, and query potential flood prone 
areas of the CT river near Mt. Toby.

(Suppose, for example, FEMA was interested in understanding flood prone areas prior to 
Hurricane Irene arriving…)

Analysis commands we will use in this exercise:

Spatial Analyst

Raster Calculator – Map Algebra (specifically the “Mosaic” function) 
Raster Overlay in the Analysis Overview lecture (Slide 6e)

Surface Analysis – Slope, Aspect, Hillshade, Viewshed

Before proceeding, let’s make sure the Spatial Analyst and 3-D Analyst extensions are available:

“Customize”, “Extensions”, click these on and activate them by right-clicking on the toolbar and 
checking “Spatial Analyst” and “3D Analyst.”

Step 1. Copy the data onto c:\temp

Step 2: Let’s first look at the topography around Mt. Toby using a couple scanned USGS 
7.5 minute quad topomaps of the area.

1. Recall that MassGIS has scanned and georeferenced toposheets available. I’ve already 
downloaded two of these files. 

2. Open up ArcCatalog
3. Navigate to the c:\temp\analysis3 folder
4. There are two topomaps in this folder: 

a. q117910.tif
b. q117914.tif

http://creativecommons.org/licenses/by-nc-sa/3.0/
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5. For each, right click properties and set the spatial reference information to: State Plane, 
NAD83, Massachusetts Mainland

6. Open ArcMap
7. Drag the two quads into a new ArcMap
8. Zoom in and find Mt Toby. 
9. You’ve all interpreted contour lines before, but take a look at the shape of Mt Toby.

Step 3: Understanding Digital Elevation Models:

Let’s turn to Digital Elevation Models (DEMs). DEMs are essentially raster files with each cell 
representing an elevation. The Wikipedia entry for DEM provides some pretty good information 
about them. See http://en.wikipedia.org/wiki/Digital_elevation_model 

In Brief: Digital elevation models are created using various methods:
1. Digitizing contour lines from paper maps, converting contour lines to point files with the 
corresponding elevation attribute.
2. Derived from stereoscope examination of orthophotos (see above link).
3. Derived from processing of remote sensing imagery (last year's Space Shuttle program using 
radar to map most of the Earth's topography) -- this has important implications for natural 
resource related work in developing countries.
4. In few cases derived from methodically GPS'ing locations on the ground in a grid pattern 
(interpolation).

Products you can develop using a DEM:  

ELEVATION: A point location with a height attribute in meters or feet. Can be height 
above ellipsoid or mean sea level (Vertical datum).

SLOPE: The relative angle of the surface in degrees (0-90) or percentage slope. 

ASPECT: The cardinal or compass direction the slope faces (0-359). 0 is true north, 90 is 
east, 180 is south, 270 is west, 359.9999 is north.

Elevation, slope and aspect are important information for studying lots of biophysical and 
human processes related to landcover change. For example, forest vegetation differs on 
SW or NE slopes.

Step 4: Free DEM data, DEM Conversion and adding to ArcMap

Digital elevation models for the U.S. can be found at a number of web sites – mostly 
PAY sites. But this USGS Geodata web site provides them for free! 

http://data.geocomm.com/dem/demdownload.html  

For this exercise, we will build a typical DEM for 2 USGS 7.5 minute Quads within the 
Pioneer Valley (Mt Toby area).  

1. I’ve downloaded two USGS 1:24,000 DEMS for the Mt Toby region from the USGS 
Seamless Server (http://seamless.usgs.gov/website/seamless/viewer.htm). These are 
DEMs based on the USGS 7.5 Minute topography quad maps. These are another type of 
zipped file.

2. Windows explorer, go to c:\Temp\analysis3\usgs124K
There are a lot of files in this folder. There are two ".zip" files in this directory. 

http://en.wikipedia.org/wiki/Digital_elevation_model
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3. UNZIP the two .zip files (36192951.zip & 80912103.zip) and store them to 
c:\temp\analysis3\usgs124K 

4. You should see a new set of files with the prefix "36192951," and "80912103." 

5. What projection are these DEM’s in? In the USGS supplied metadata, I discovered that 
they are in GCS North American 1983. 

6. Add the two DEMs to your ArcMap document. 
7. View the full extent of the map (the globe icon)
8. For the two topomaps, set the transparency of them to 30%.

a. Right click, properties, display
b. If the topomaps are not at the top of your table of contents, move them up above 

the DEM grids.
c. Compare the DEM to the topomaps. How do you interpret the shades of gray in 

the DEM?

9. Turn off the topomaps in the TOC so you can just look at the elevation data from the two 
grids.

10. View it all by pressing the globe icon (full extent).

Step 5: Check to make sure grids are in similar cell sizes, and similar elevation units. How 
would you do this?

Note: make sure Spatial Analyst is set on: Tools menu, extensions. View, toolbars.

1. Cell sizes: TOC, properties, source tab and look for cell size information
2. Elevation units: 

i. First, I looked at the TOC and noticed that the ranges for both DEMs look 
about the same. But we don’t know what unit this is in – feet or meters. You 
might know because you know the area, but suppose you didn’t.

ii. Next, I looked for metadata for each grid. I had to find the appropriate info file 
that told me what units their data were in. 

1. Press the Add Data button
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2. Meters. When I looked at two others nearby they were in feet – 
believe it or not -- so if we were using not two DEMS but four we'd 
have to convert the other two to compatible units. We won't do that 
due to time, but if you wanted to convert a value you could use 
the Spatial Analyst Raster Calculator to convert meters to feet 
(e.g., 1 meter = 3.280839 feet.  For example, ( [36192951] * 
3.280839) converts meters to feet.  

Step 6: Mosaic the two DEM grids together 

First we need to create a new rster dataset for the new mosaic to target.  
ArcToolbox > Data Management > Raster > Create Raster Dataset.  
Create a folder named “Mosaic” and in that a file called “Mossaic.”

Expand to full extent again. Notice that there is a seam problem between 
the two grids. To try and fix that, we will put the two together into one 
grid. This tool is available in ArcToolbox > Data Management Tools > 
Raster > Raster Dataset > Mosaic.
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After clicking “OK” the new mosaicked DEMs will show up in your TOC named “Mosaic.”

Many tasks in ArcGIS 10 can be performed from ArcToolbox, but also using Map Algebra 
in the raster calculator, using scripts, constructing models in the model builder, etc…We 
will also perform this mosaic operation using Map Algebra, so you get a little more 
familiar with this alternative way of working.
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Spatial Analyst’s “Raster Calculator” is a powerful tool. Map Algebra is a 
powerful language to do lots of different processing between grids. We could 
spend several days on the types of processing you might do with the Map 
Algebra functions. 

1. On the Spatial Analyst dropdown arrow, choose “Raster Calculator”
2. The tricky thing that isn’t well described in the ArcMap help is there are 

lots of raster calculator COMMANDS or FUNCTIONS you can do. The 
one we want to use here is “Mosaic”.

3. Type in “Mosaic(”
4. Double click on “102936593”. You should see “[102936593]” in the equation 

area.
5. Type a comma “,”
6. Double click on “80912103”. You should see “[80912103]” appear in the 

equation area.
7. Close the function with a “)”
8. Your statement in the equation area should be:

mosaic([102936593],[80912103])

9. Click Evaluate. A new grid will be produced called “Calculate” that is the 
two DEM grids combined.

10. In the TOC, properties, change the TOC name from “Calculate” to 
“DEM GRID”. You can remove the other two earlier DEM grids now.

11. Notice that the gaps were filled in by the mosaic command to “smooth 
the transition between them.” 

Step 7: Creating slope, aspect, hillshade and viewshed grids using Spatial Analyst:  

For a variety of environmental-related studies, slope and aspect are important information. With 
our new Digital elevation model (DEM) created, we can now calculate the slope and aspect of our 
terrain. This is useful for a number of analyses.

Recall that 

SLOPE: The relative angle of the surface in degrees (0-90) or percentage slope. 

ASPECT: The cardinal or compass direction the slope faces (0-359). 0 is true north, 90 is 
east, 180 is south, 270 is west, 359.9999 is north.

Note: Refer back to Appendix 14, Slide 12 – this is “Surface Analysis”

To calculate a Slope grid:

1. ArcToolbox > Spatial Analyst > Surface > Slope
2. Input surface “Mosaic”
3. Output measurement in percent rise
4. Go with the defaults for z factor and cell size
5. Output raster: c:\temp\analysis3\slope
6. Click OK
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7. A slope grid will be created.
8. You should see some very steep places around Mt Toby, and flat areas in the river 

valley. 

To calculate an Aspect grid:

1. ArcToolbox > Spatial Analyst > Surface > Aspect
2. Input surface “Mosaic”
3. Output raster: c:\temp\analysis3\aspect
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4. Click OK
5. An aspect grid will be created.
6. The various cells now represent aspect as measured in compass degrees. 

To calculate a Hillshade grid:

1. ArcToolbox > Spatial Analyst > Surface > Hillshade
2. Input surface “Mosaic”
3. Azimuth and Altitude has to do with the position of the sun (use defaults for this exercise)
4. use defaults for z-factor and cell size
5. c:\temp\analysis3\hillshade as the grid name
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6. Click OK
7. A hillshade grid will be created. This helps one visualize topographic relief.

To calculate a viewshed (what can be seen and not seen from a location): 

I’ve created a simple point geodatabase layer as an example. 

1. Add Data
2. Choose the viewpoint.mdb geodatabase, add the “viewpoint” point layer
3. One point should appear overlaid on your hillshade.
4. Create a new new rster dataset for the new mosaic to target.  
5. ArcToolbox > Data Management > Raster > Create Raster Dataset.  Create a 

folder named “Viewshed” and in that a file called “viewshed.”
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6. ArcToolbox > Spatial Analyst > Surface > Viewshed
7. Input raster – Mosaic
8. Observer points: viewpoint
9. Choose “viewshed” as your output raster

10. Click OK
11. The output viewshed grid will show locations that can be seen (visible) and not visible 

areas.
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Step 8: Doing queries on grids. Let's compute the flood prone areas.

Let’s return back to the original exercise goal – querying flood prone locations around Mt Toby. 
To do this, we can once again use the raster calculator and our DEM.

These are dates for the 10 highest water levels of the Connecticut River since 1945, recorded by 
flood watchers in Northampton and measured in feet above sea level.

May 31-June 1, 1984 - 120.7 feet
April 6, 1960 - 119.9
Jan. 1, 1949 - 118.6
April 1, 1987 - 118.0
March 15, 1977 - 116.2
April 3, 1976 - 115.7
April 23, 1969 - 115.5
April 1, 1951 - 115.4
April 24, 1958 - 115.3
April 19, 1982 - 114.8

What might the calculations be in the raster calculator to identify flood prone areas? Use the 
Raster calculator to convert “Mosaic” from meters to feet. ArcToolbox > Spatial Analyst Tools > 
Map Algebra > Raster Calculator

 [Value] * 3.280839) converts meters to feet to produce “Mosaic_ft” (grid layer)
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Raster calculator: [Mosaic_ft] <= 114 to produce new layer called “floodprone”

IF TIME PERMITS: Changing the cell size of a raster grid – a common need

Often you need to change the resolution of a grid to another size so that it can be used in 
raster calculator with another layer. For example, I’ve run into this problem with a Landsat 
image (28.5 meter cell) and a USGS DEM (30 meter cell).

Here we will reproject “Mosaic” to a 30m DEM.  
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a. ArcCatalog > Data Management > Projections and Transformations > Raster > 
Project Raster

b. Choose “Mosaic” as your input raster 

c. Save your output raster dataset as “Mosaic_30m”

d. Choose your output coordinate system

e. Set output cell size to 30m

The 30m DEM will be added to the TOC and you can confirm cell size by right 
clicking on the layer > Layer Properties > Source tab.  Under Raster Information 
you will see Cellsize.  

 

Conclusion:
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Look at the spatial analyst menu. There are other functions we didn’t go over… but I talked about 
in my Analysis overview 

Distance (Appendix 14, Slide 4b)
Density
Interpolation (creating a grid from a set of points)
Statistical functions (slides 11a-c)
Reclassify – convert some values to some other values (slide 8)



Homework 1: GIS Literature Search
Date due: 9/15. Deliverable: Pdf document submitted on Moodle. 

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Goal: The idea of this homework is to give you a chance to learn about how GIS has 
been applied in an area or field of your interest. Research different applications of 
GIS. Gain familiarity with the breadth of GIS applications. Explore what datasets are 
used for different GIS projects and how they are represented in a GIS.

Assignment:

1. Do a literature search of different GIS projects that are of substantive interest 
to your general field of study. 

2. In the introduction to the paper, provide a paragraph or two explaining your 
professional interests. What area do you see yourself working in upon 
graduation?  

3. Select and review three (3) GIS applications related to your area of interest. If 
you have trouble finding applications specifically in your area, choose a second 
area of interest or some area that is closely aligned with your interests. Answer 
the questions listed below. Each review should be no more than ½ page in 
length.

 What was the purpose of the project
 How was GIS used for analysis?
 Why was GIS helpful (or was it)? Could they have done it without GIS? 
 What data were used? Where did the data come from? Was it developed by 

the researchers or from some secondary source? 
 What software was applied? 

NOTE – TAKE NOTICE OF ONE IMPORTANT REQUIREMENT! DO NOT 
IDENTIFY ALL OF YOUR STUDIES FROM INTERNET-BASED 
RESOURCES. I EXPECT AT LEAST 2 CASES TO BE FROM MORE 
STANDARD LITERATURE (BOOKS, JOURNAL ARTICLES). 

4. Complete your 2-page review with a conclusion on how GIS might be applied in 
your area of interest. Your own ideas are welcome!  

5. In all cases, you must provide a proper citation for your literature search. An 
example would be (note, some ArcNews articles don't provide the authors name, 
in these cases just use ESRI (the publishers of ArcNews and of ArcGIS, ArcView 
software):

http://creativecommons.org/licenses/by-nc-sa/3.0/


ESRI. 2000. Bangladesh Establishes a GIS-Based Agricultural and Land 
Resources Information System. ArcNews. Vol. 22, No. 1.

Dhakal, A. S., T. Amada, and A. Aniya. 2000. Landslide Hazard Mapping and 
its Evaluation Using GIS: An Investigation of Sampling Schemes for a Grid-
Cell Based Quantitative Method. Photogrammetric Engineering and Remote 
Sensing. 66(8): 981-989.

Carolina Population Center. 2000. Demographic and Environmental Change in 
Nang Rong. http://www.cpc.unc.edu/services/spatial/nangrong.htm. 
Accessed January 17, 2003. 

Resources to use:

You can find your information on the web, from existing books or from journals.  
Journals include:

 Geocarto international (Morrill) 
 Photogrammetric Engineering and Remote Sensing (PE&RS; Physical Science 

library),  
 International Journal of Remote Sensing
 ESRI ArcNews (http://www.esri.com/news/arcnews/arcnews.html)
 Geoworld (http://www.geoplace.com/gw/)
 ArcUser: The magazine for ESRI software users 

http://www.esri.com/news/arcuser/),
 UMass digital library  http://www.library.umass.edu/cgi-bin/aka/databases.cgi
 Journal of Geographic Information and Decision Analysis 

http://www.geodec.org
 List of links to GIS journals, books and bibliographies http://www.geo.uni-

bonn.de/members/haack/gis-journals.html
 The Social Science Citation Index 

(http://www.library.umass.edu/research/html/webofs.html) and Ingenta 
Uncover (http://www.library.umass.edu/research/html/uncweb.html) are 
good resources on academic publications.

 Geosource: A good reference link website. 
http://www.library.uu.nl/geosource/cat9.html

 Google scholar http://scholar.google.com  

Social science/policy applications will be harder to find, perhaps, but try. They 
are out there. The biggest hurdle may be what is available in the Umass library. 
Journals that are not necessarily focused on GIS/RS often have individual articles 
that do use GIS/RS. For example, Demography, Landscape Ecology, Land 
Degradation and Development, Environmental Management, Mountain Research 
and Development, Journal of Arid Lands, Environmental Modeling and 
Assessment, Social Science Computer Review, Forest Ecology and Management, 
Wildlife Society Bulletin, Urban Studies, and so on.

Books include:

Beyond maps : GIS and decision making in local government, O’Looney
Open Access: GIS in Government (ESRI Press) – see me to borrow

http://www.cpc.unc.edu/services/spatial/nangrong.htm
http://www.esri.com/news/arcnews/arcnews.html
http://www.esri.com/news/arcnews/arcnews.html
http://www.esri.com/news/arcnews/arcnews.html
http://www.geoplace.com/gw/
http://www.geoplace.com/gw/
http://www.geoplace.com/gw/
http://www.esri.com/news/arcuser/
http://www.esri.com/news/arcuser/
http://www.esri.com/news/arcuser/
http://www.library.umass.edu/cgi-bin/aka/databases.cgi
http://www.geodec.org
http://www.geodec.org
http://www.geodec.org
http://www.geodec.org
http://www.geodec.org
http://www.geodec.org
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.geo.uni-bonn.de/members/haack/gis-journals.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/webofs.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.umass.edu/research/html/uncweb.html
http://www.library.uu.nl/geosource/cat9.html
http://scholar.google.com
http://scholar.google.com


Conservation Geography: Case Studies in GIS, Computer Mapping and 
Activism (ESRI Press) – see me to borrow
Planning Support Systems (ESRI Press) – See me to borrow
GIS in Public Policy (ESRI Press) – See me to borrow

… and there are lots of GIS related books in the library.



Homework 2: 
Downloading a basemap from MassGIS and setting up the 

georeferencing information in ArcGIS

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic Information 
(MassGIS), Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). 

Any further use of these datasets in other situations should acknowledge this organization.

Date due: 9/22. Hand in pdf document in Moodle.

The first step to creating a GIS is to establish a “main project ArcMap document” 
with a “basemap” that you can use to georeference all other future GIS layers. In 
Homework 3, we will be creating this basemap from scratch. But especially in the era 
of the Internet, basemaps can often be acquired that are already georeferenced 
which can save you some work. USGS topomaps often make good basemaps 
(depending on the spatial scale needs of your project). Your job in this exercise is to 
download an already georeferenced and rectified USGS quad topomap (MrSid 
format) from MASSGIS for a portion of Northampton and the Mass Highway Roads 
layer for the area you select. In Arc Catalog, set their projection information if 
needed. Add them to a new Arc Map document. Use the file, print option to print 
your map to a pdf file. This procedure was fully described in the “Searching for Data 
– MassGIS” in-class exercise. 

Deliverable:

Print your map to a pdf file and upload to Moodle under homework 2. Provide in the 
comments field in SPARK any problems you may have encountered. 

http://creativecommons.org/licenses/by-nc-sa/3.0/


Homework 3: 
Scanning, georeferencing, and rectifying a topographic map

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic Information 
(MassGIS), Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). 

Any further use of these datasets in other situations should acknowledge this organization.

Date due: 10/4 (Hand in via Moodle)

Often in GIS you need to georeference a scan of a paper map or some other GIS 
product (like an aerial photograph). Your job in this exercise is to do this for a paper 
map I have already scanned.  The steps used in this homework were described in the 
lab manual section entitled “Georeferencing a scanned map using ArcGIS.”

Tasks:

1. Print out and review the Belchertown MA topomap (jpg) that is available on the 
course website. 

It is a component of a larger USGS topographic map. Check the map 
projection/datum information which is shown in Attachment A below.  

On the scanned map printout, locate at least 4 ground “control points” (GCP) 
using intersection points of the projection grid on the map. Carefully record each 
GCP’s projection coordinates.

2. Optional: For students who have never scanned anything before, you could try 
printing out the map and scan it. Find an available scanner.  Save the jpg file to a 
NEW FOLDER on thumb drive or email it to yourself as an attachment to work on 
it later. 

3. If you feel like you don’t need scanning practice, you can simply use the .jpg file 
provided on the course webpage and also on the Scholarworks system. In 
Firefox, right click on the hyperlink and use “save as” and save it to a folder on 
your computer or your thumb drive.  

4. Locate the image in ArcCatalog and specify the coordinate system for the image 
(refer to Appendix A).

5. Georeference the image using ArcMap. If you can, try and get the RMS error to 
below .5 (pixels!). It may be difficult to do so, because of the quality of the scan. 
Also, try to use at least different GCPs on different coordinate crosshairs to see if 
that improves things. But don’t spend a huge amount of time (e.g., more than an 
hour) if you can’t get it under .5. But give it a try. Record your RMS error. 

http://creativecommons.org/licenses/by-nc-sa/3.0/


6. Rectify the image. Call the result image “yourlastname.tif”

7. WHAT TO HAND IN ON MOODLE:

Take a snapshot of your screen. You can do this by pressing simultaneously the 
CTRL key and the PRNT SCRN key. This gets stored in computer memory (the 
clipboard). Open up Word. Create a new Word or Open Office Writer document. 
Use Edit, Paste to paste the snapshot onto a page. 

In addition to the screen shot, write in your document:

a. Your name
b. Your RMS error 
c. Write any other problems you may have had with this exercise
d. Using My Computer or Windows Explorer, look at the folder where your tiff 

file was stored. (Make sure you can look at the “details” – do a “view, 
details” so you can see the extension names of these files). What file(s) 
reside there? Describe how you would backup this data.

e. Upload your word document to Moodle (HW 3)



Attachment A: USGS Map metadata



Homework 4:
Online digitizing exercise 

 
2011 Charlie Schweik

Note: This work is licensed under the Creative Commons Attribution-
NonCommercial-ShareAlike 3.0 Unported License. To view a copy of this 

license, visit http://creativecommons.org/licenses/by-nc-sa/3.0/.

Datasets used for this exercise were generously provided by the Office of Geographic Information 
(MassGIS), Commonwealth of Massachusetts, Information Technology Division (www.mass.gov/mgis). 

Any further use of these datasets in other situations should acknowledge this organization.

Due Date: 10/14

Your job in this exercise is to create a new file Geodatabase for some roads and 
buildings that are in Belchertown. 

Note: The steps used in this homework were described in the in-class exercise 
entitled “Online Digitizing and Editing of GIS Layers.”

1. Download an already georeferenced USGS 7.5 minute topomap from MassGIS 
like you did back in HW3 (or use the one you worked on in HW3). Having this 
existing topomap already in raster form and georeferenced allows you to use it as 
a basemap. This is a common first step in building a GIS – all new layers are 
georeferenced to this base layer. Check in ArcCatalog that the projection 
information is assigned. 

2. In ArcCatalog, create a new file geodatabase called “yourlastname”.  

3. Create a roads feature class. What kind of geometry should you use to represent 
roads? Import the projection information from the already georeferenced topo 
map. Set the appropriate geometry and set the spatial reference (projection) 
information.  Create a new attribute called “roadname” and make it text 50 long. 
Add a “roadname” field in the attribute table and define it as text 100 long.

4. Create a buildings feature class. Do the same thing for this as you did for step 4. 
Create a “bldgname” attribute and define it as text 100 long.

5. Drag the roads and point feature classes (currently featureless) over to the 
ArcMap table of contents. Get the roads feature class “active” (meaning click on it 
in the table of contents so it is highlighted). Start editing the roads feature class.  
Using the rectified image as a background layer, digitize at least 10 road 
segments. Be as accurate as possible and use editing functions if you make a 
mistake. Enter in some made up names for the segments you have digitized in 
the attribute table (use the attribute table icon in the editing toolbar). Stop 
editing.
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6. In the table of contents, get the building feature class “active.” Start editing it. 
Digitize at least 10 building points. Enter in some made up names for the 
buildings you’ve digitized using the attribute table icon.

7. Print out the ArcMap to a pdf file with your layers on it. 

What to hand in:

a. Upload your pdf file to Moodle
b. A short comment in Moodle explaining any problems you had with this 

assignment. 
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